TI-Nspire™ CX II Handhelds Guidebook

TI-Nspire™ CX II
TI-Nspire™ CX II CAS

Learn more about TI Technology through the online help at education.ti.com/eguide.
**Important Information**

Except as otherwise expressly stated in the License that accompanies a program, Texas Instruments makes no warranty, either express or implied, including but not limited to any implied warranties of merchantability and fitness for a particular purpose, regarding any programs or book materials and makes such materials available solely on an "as-is" basis. In no event shall Texas Instruments be liable to anyone for special, collateral, incidental, or consequential damages in connection with or arising out of the purchase or use of these materials, and the sole and exclusive liability of Texas Instruments, regardless of the form of action, shall not exceed the amount set forth in the license for the program. Moreover, Texas Instruments shall not be liable for any claim of any kind whatsoever against the use of these materials by any other party.

© 2021 Texas Instruments Incorporated

TI-Nspire™ CX II License Agreement: education.ti.com/license

TI-Nspire™ CX II Warranty: education.ti.com/warranty

Limited Warranty. This warranty does not affect your statutory rights.

Vernier DataQuest™ is a trademark of its respective owner.

Actual products may vary slightly from provided images.

TI-Nspire™ CX II Handhelds: TI-Nspire™ CX II, TI-Nspire™ CX II CAS, TI-Nspire™ CX II-T, TI-Nspire™ CX II-T CAS, TI-Nspire™ CX II-C CAS, and TI-Nspire™ CX II EZ-Spot
## Contents

**Getting Started with TI-Nspire™ CX II Handhelds** ................................. 1

- About Math Modes ........................................................................................................... 1
- TI-Nspire™ CX II Handheld Keys .................................................................................. 2
- Preparing the TI-Nspire™ CX II Handheld for Use .......................................................... 2
- Turning On the TI-Nspire™ CX II Handheld for the First Time ...................................... 3
- Adjusting the Brightness of the Backlighting ................................................................. 5
- Using the TI-Nspire™ Touchpad ...................................................................................... 5
- Understanding the Scratchpad ......................................................................................... 6
- Using the Home Screen ................................................................................................... 6
- The TI-Nspire™ CX II Handheld Screen ........................................................................ 8
- Using Hints ....................................................................................................................... 9
- Using Keyboard Shortcuts ............................................................................................... 9

**Using the Scratchpad** ............................................................................................... 15

- Opening and Closing the Scratchpad .............................................................................. 15
- Calculating with Scratchpad ............................................................................................. 15
- Inserting Items from the Catalog .................................................................................... 16
- Viewing the History ......................................................................................................... 19
- Editing Scratchpad Expressions ...................................................................................... 20
- Graphing with the Scratchpad .......................................................................................... 21
- Working with Variables in the Scratchpad ...................................................................... 25
- Saving the Scratchpad Contents ..................................................................................... 25
- Clearing Scratchpad Contents .......................................................................................... 26

**Working with Documents on TI-Nspire™ CX II Handhelds** ............................... 27

- Opening a Document ....................................................................................................... 27
- Creating a New Document ................................................................................................. 27
- Saving Documents ............................................................................................................ 28
- Working with Applications .............................................................................................. 30
- Using the Application Menu .............................................................................................. 35
- Context Menus .................................................................................................................. 36
- Working with Problems and Pages ................................................................................... 36
- Adding a Problem to a Document .................................................................................... 36
- Viewing and Reordering Pages in a Document ................................................................. 37
- Copying, Pasting, and Deleting Problems ....................................................................... 40
- Renaming a Problem ........................................................................................................ 41
- Adding a Page to a Problem .............................................................................................. 41
- Moving Through Pages in a Document ............................................................................ 42
- Managing Documents ..................................................................................................... 42
- Closing a Document ......................................................................................................... 45
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Understanding the TI-Nspire™ Tools</td>
<td>46</td>
</tr>
<tr>
<td>Working with Images</td>
<td>50</td>
</tr>
<tr>
<td>Working with Images on a Handheld</td>
<td>50</td>
</tr>
<tr>
<td>Working in a TI-Nspire™ CX Premium Teacher Software Classroom</td>
<td>53</td>
</tr>
<tr>
<td>Using Wireless Communication Hardware</td>
<td>53</td>
</tr>
<tr>
<td>Connecting to the TI-Nspire™ CX Navigator™ System</td>
<td>54</td>
</tr>
<tr>
<td>Understanding File Transfers</td>
<td>56</td>
</tr>
<tr>
<td>Configuring Handhelds</td>
<td>59</td>
</tr>
<tr>
<td>Checking Battery Status</td>
<td>59</td>
</tr>
<tr>
<td>Recharging the Handheld</td>
<td>59</td>
</tr>
<tr>
<td>Changing Handheld Settings</td>
<td>60</td>
</tr>
<tr>
<td>Changing a Preferred Language</td>
<td>61</td>
</tr>
<tr>
<td>Customizing the Handheld Setup</td>
<td>61</td>
</tr>
<tr>
<td>Customizing Document Settings</td>
<td>62</td>
</tr>
<tr>
<td>Customizing Graphs &amp; Geometry Settings</td>
<td>66</td>
</tr>
<tr>
<td>Viewing Handheld Status</td>
<td>68</td>
</tr>
<tr>
<td>Replacing TI-Nspire™ Rechargeable Batteries</td>
<td>69</td>
</tr>
<tr>
<td>Precautions for Rechargeable Batteries</td>
<td>70</td>
</tr>
<tr>
<td>Connecting Handhelds and Transferring Files</td>
<td>71</td>
</tr>
<tr>
<td>Connecting Handhelds</td>
<td>71</td>
</tr>
<tr>
<td>Transferring Files between Handhelds</td>
<td>72</td>
</tr>
<tr>
<td>Transferring Files between Computers and Handhelds</td>
<td>73</td>
</tr>
<tr>
<td>Handling Errors Resulting from Sending Folders</td>
<td>75</td>
</tr>
<tr>
<td>File Management</td>
<td>78</td>
</tr>
<tr>
<td>Checking Available Storage</td>
<td>78</td>
</tr>
<tr>
<td>Freeing Storage</td>
<td>78</td>
</tr>
<tr>
<td>Resetting the Storage</td>
<td>81</td>
</tr>
<tr>
<td>Updating the Handheld Operating System</td>
<td>83</td>
</tr>
<tr>
<td>What You Need to Know</td>
<td>83</td>
</tr>
<tr>
<td>Finding Operating System Updates</td>
<td>84</td>
</tr>
<tr>
<td>Performing the OS Update</td>
<td>85</td>
</tr>
<tr>
<td>Updating the OS on Multiple Handhelds</td>
<td>88</td>
</tr>
<tr>
<td>OS Upgrade Messages</td>
<td>88</td>
</tr>
<tr>
<td>TI-Nspire™ CX II Connect</td>
<td>91</td>
</tr>
<tr>
<td>Getting Started with TI-Nspire™ CX II Connect</td>
<td>91</td>
</tr>
</tbody>
</table>
Getting Started with TI-Nspire™ CX II Handhelds

The TI-Nspire™ CX II and the TI-Nspire™ CX II CAS are the newest handhelds in the TI-Nspire™ family of products. Featuring a backlit color display and a slimmer form, the handhelds provide touchpad navigation, dynamic graphing, and interactive computer features.

The handhelds and the TI-Nspire™ software share the same functionality, enabling you to transfer class assignments from the handheld to the computer or transfer documents to the handheld when you need to be mobile. Start assignments at school, and then finish the work at home to take advantage of the software’s full-color display and easy-to-use navigation. Use the software to download the latest software and handheld operating system updates as they become available to ensure you have the latest enhancements.

This guide covers the following TI-Nspire™ CX II handhelds:

- TI-Nspire™ CX II / TI-Nspire™ CX II CAS
- TI-Nspire™ CX II-T / TI-Nspire™ CX II-T CAS
- TI-Nspire™ CX II-C CAS
- TI-Nspire™ CX II EZ-Spot

While they operate identically in many ways, there are a few distinctions. If there are differences between the Numeric, Exact Arithmetic, or CAS handhelds, it is pointed out and the appropriate operation is described.

About Math Modes

TI-Nspire CX II handhelds perform calculations in one of three modes: Numeric, Exact Arithmetic, or Computer Algebra System (CAS).

**Numeric mode** supports results in terms of floating point numbers, integers, and stacked fractions only.

**Exact Arithmetic mode** supports results in terms of floating point numbers, integers, stacked fractions, π, e, radicals \( \sqrt{\phantom{1}} \), and other constants such as \( \ln(5) \) and \( \sin(2) \).

**CAS mode** supports the same results as Exact Arithmetic as well as symbolic manipulation such as \( x+x \), and CAS functions such as symbolic factoring, solving equations, limits, and indefinite integration.

The math modes that are available will depend on which TI-Nspire CX II handheld model you have:

<table>
<thead>
<tr>
<th>Handheld Model</th>
<th>Numeric</th>
<th>Exact Arithmetic</th>
<th>CAS</th>
</tr>
</thead>
<tbody>
<tr>
<td>TI-Nspire CX II</td>
<td>✔️</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TI-Nspire CX II CAS</td>
<td>✔️ 1</td>
<td>✔️</td>
<td>✔️</td>
</tr>
</tbody>
</table>
### Getting Started with TI-Nspire™ CX II Handhelds

<table>
<thead>
<tr>
<th>Handheld Model</th>
<th>Numeric</th>
<th>Exact Arithmetic</th>
<th>CAS</th>
</tr>
</thead>
<tbody>
<tr>
<td>TI-Nspire CX II-T</td>
<td>✔️ 2</td>
<td>✔️</td>
<td></td>
</tr>
<tr>
<td>TI-Nspire CX II-T CAS</td>
<td>✔️ 1</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>TI-Nspire CX II-C CAS</td>
<td>✔️ 1</td>
<td>✔️</td>
<td>✔️</td>
</tr>
</tbody>
</table>

1. CAS mode turned off
2. Exact Arithmetic mode turned off

### TI-Nspire™ CX II Handheld Keys

Use the TI-Nspire™ Touchpad as you would a laptop touchpad. You can also press the outer edges to move right, left, up, and down.

- **esc** Removes menus or dialog boxes from the screen. Also stops a calculation in progress.
- **on** Turns on the handheld. If the handheld is on, this key displays the home screen.
- **doc** Opens the Document menu.
- **tab** Moves to the next entry field.
- **menu** Displays the application or context menu.
- **shift** Makes the next character typed upper-case.
- **del** Deletes the previous character.
- **var** Displays stored variables.
- **enter** Evaluates an expression, executes an instruction, or selects a menu item.

**Note:** A symbol on a key indicates access to multiple options. To access an option, press repeatedly or use the arrow keys on the Touchpad. Press or click to select the option.

### Preparing the TI-Nspire™ CX II Handheld for Use

The TI-Nspire™ CX II handheld comes equipped with a Li-ion rechargeable battery. The handheld also comes with the following accessories:

- Standard mini-A to mini-B USB cable for transferring files to another handheld
• Standard A to mini-B USB cable for transferring files to and from a computer and for charging the battery

**Charging the Handheld**

- Using one of the following options, charge the battery for at least four hours to ensure optimum performance.
  - Connect the handheld to a computer using a standard A to mini-B USB cable. To download software that includes a driver, go to education.ti.com/software.
  - Connect to a wall outlet using a TI wall adapter (sold separately).
  - If in a classroom setting, place the handheld or multiple handhelds in a TI-Nspire™ CX Docking Station or a TI-Nspire™ Docking Station.

_Note:_ The TI-Nspire™ CX II handheld has a Deep Sleep feature to maximize battery life during extended storage periods. To put the handheld in Deep Sleep mode, press and hold down the blue reset button on the back of the handheld for at least 4 seconds. To wake the handheld from Deep Sleep mode, press for at least 4 seconds or apply USB (computer or wall adapter) or Docking Station power. After waking the handheld, you can turn it on anytime by pressing .

_Note:_ For more information about recharging batteries, see *Configuring TI-Nspire™ Handhelds*.

**Turning On the TI-Nspire™ CX II Handheld for the First Time**

After charging the battery, press to turn on the handheld. A progress bar is displayed while the operating system loads. Next, choose preferences for language and font size when prompted.

_Note:_ To turn the handheld off, press . The settings and memory contents are retained.

**Using Automatic Power Down™**

To prolong battery life, the Automatic Power Down™ (APD™) feature turns off the handheld after three minutes of inactivity. When this happens, press to turn the handheld on and return to the last document or last menu accessed. To change the default setting, press to access the **Handheld Setup** screen where you can change the **Power Standby** setting.

_Note:_ For more information about setting up the handheld, see *Configuring Handhelds*.

**Choosing a Language**

After the OS is loaded, select a preferred language.
1. Press ▶ to open the drop-down list.
2. Press ▼ to scroll through the languages, and then press 逃跑 or 确认 to select a language.
3. Press tab to highlight the OK button, and then press 逃跑 or 确认 to save the language selection.

Choosing a Font Size

Next, select a font size for the display.

1. Press ▶ to open the drop-down list.
2. Press ▼ to highlight the font size, and then press 逃跑 or 确认 to select it.
3. Press tab to highlight the OK button, and then press 逃跑 or 确认.

The Welcome! screen opens.
4. To continue, press \( \text{ } \) or \( \text{ } \) to select **OK**.

The **Home** screen opens.

---

**Adjusting the Brightness of the Backlighting**

The screen on the TI-Nspire™ CX II handheld is backlit making it easier to use in all lighting conditions. By default, the brightness setting is medium. To adjust the backlight brightness:

- **Dimmer**: Press and hold [ctrl] and tap \( - \).
- **Brighter**: Press [ctrl] and tap \( + \).

**Using the TI-Nspire™ Touchpad**

Use the Touchpad to navigate or complete any task that can be completed using the arrow and **Enter** keys. Use the Touchpad to navigate in two ways:

- Use it like a computer touchpad by moving your fingertip in a sliding motion on the center area of the Touchpad to activate and move the mouse pointer. Click or tap the center of the Touchpad to select a menu option or complete an action.
• Press the arrow keys on the outside edge of the Touchpad to nudge the mouse pointer up, down, left, or right, and then click \( \text{tab} \) or press \( \text{enter} \) to complete an action.

If you hold down an arrow key, the mouse pointer continues to move in that direction.

**Note:** If the mouse pointer is visible on a command or file, click or tap \( \text{enter} \) in the center of the Touchpad to select that command or file. If the command or file is highlighted, move the pointer over that item or press \( \text{enter} \) to select it.

When working in an application, use the Touchpad to access more information about problems. For example, hovering over a Graphs & Geometry object displays information about variables used in that object and about tools that are available.

Some users prefer to customize their Touchpad settings; to speed up or slow down their pointer, or to enable tap to click. To change the default settings for the Touchpad, see *Configuring Handhelds*.

**Understanding the Scratchpad**

Use the Scratchpad to make quick calculations and graphs without affecting the current TI-Nspire™ document. For example, when you need a quick way to test a calculation before you add it to a document, you can open the Scratchpad application and perform the calculation. Then, you can either discard the calculation or add it to a document. For more information about the Scratchpad, see *Using the Scratchpad*.

**Using the Home Screen**

The **Home** screen provides a starting point for all activities performed on a handheld:

• Opening the scratchpad for quick calculations and graphing
• Creating new documents
• Opening and managing existing documents
• Defining settings and viewing status
• Viewing hints for operating the handheld
• Accessing recent documents
• Returning to the current document

**Note:** Press \( \text{menu} \) to toggle between the **Home** screen and the current document.

**Home Screen Options**

<table>
<thead>
<tr>
<th>Menu Option</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scratchpad</td>
<td>Use the Scratchpad menu options to open a Calculator or Graph application without affecting your document.</td>
</tr>
</tbody>
</table>
## Menu Option

### Purpose

While in Scratchpad, press \[ \text{ } \] to toggle between Scratchpad applications: Calculate and Graph.

<table>
<thead>
<tr>
<th>Menu Option</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>Calculate</td>
<td>Opens the Scratchpad with a Calculator application active. From the Home screen, type [ A ].</td>
</tr>
<tr>
<td>Graph</td>
<td>Opens the Scratchpad with a Graph application active. From the Home screen, type [ B ].</td>
</tr>
</tbody>
</table>

### Documents

To select options for working with documents, press the associated number or use the Touchpad to select an icon then press \[ \text{ } \] or \[ \text{ } \].

<table>
<thead>
<tr>
<th>Menu Option</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>Opens a new TI-Nspire™ document with available applications listed.</td>
</tr>
<tr>
<td>Browse</td>
<td>Opens the file browser where you can open existing TI-Nspire™ documents or send files to others.</td>
</tr>
<tr>
<td>Recent</td>
<td>Lists the five most recently saved documents.</td>
</tr>
<tr>
<td>Current</td>
<td>Goes to the document that is currently open.</td>
</tr>
<tr>
<td>Settings</td>
<td>Check the status of the handheld and change settings.</td>
</tr>
</tbody>
</table>

### Application icons

To add a new page to the current document, select an application icon. If no document is open, a new document opens with the selected application on a new page.

<table>
<thead>
<tr>
<th>Application Icon</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>Calculator</td>
<td>Adds a page to a document for entering and evaluating math expressions.</td>
</tr>
<tr>
<td>Graphs</td>
<td>Adds a page for graphing and exploring functions.</td>
</tr>
<tr>
<td>Geometry</td>
<td>Adds a page for creating and exploring geometric shapes.</td>
</tr>
<tr>
<td>Lists &amp; Spreadsheet</td>
<td>Adds a page for working with data in tables.</td>
</tr>
<tr>
<td>Menu Option</td>
<td>Purpose</td>
</tr>
<tr>
<td>--------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Data &amp; Statistics</td>
<td>Adds a page and provides tools used to visualize sets of data in different types of plots and provides tools for manipulating data sets to explore relationships between the sets of data.</td>
</tr>
<tr>
<td>Notes</td>
<td>Provides text editing functions for adding text to TI-Nspire™ documents for use as notes or to share with other users.</td>
</tr>
<tr>
<td>Vernier DataQuest™</td>
<td>Adds a page for collecting and analyzing data from sensors or probes.</td>
</tr>
</tbody>
</table>

To learn more about applications and documents, see *Working with Documents on TI-Nspire™ Handhelds*.

**The TI-Nspire™ CX II Handheld Screen**

When you are working in a document on a handheld, icons at the top of the screen provide information about the status of handheld operations and provide an easy way to change settings. The icons are described below.

![Screen Icon Diagram](image)

<table>
<thead>
<tr>
<th>Icon</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>➙</td>
<td><strong>Page scrolling arrows</strong> - Use the touchpad to click these arrows and scroll through the pages in a document.</td>
</tr>
<tr>
<td><img src="image" alt="Page Tab Icon" /></td>
<td><strong>Page tab</strong> - Labels the problem number and page number of the active page. For example, a label of 1.2 identifies Problem 1, Page 2. If problems are named, hover the pointer over a tab to view the page name.</td>
</tr>
<tr>
<td>*Doc</td>
<td><strong>Document name</strong> - Shows the current document name. An asterisk by the document name indicates changes were made since the document was last saved.</td>
</tr>
<tr>
<td>Icon</td>
<td>Function</td>
</tr>
<tr>
<td>------</td>
<td>----------</td>
</tr>
<tr>
<td>saved. Click the name to open the <strong>Documents</strong> menu.</td>
<td></td>
</tr>
<tr>
<td>Press to Test - Indicates that the handheld is in Press-to-Test mode.</td>
<td></td>
</tr>
<tr>
<td>Login status - Shows whether the handheld is searching for an access point (blinking), found an access point (solid), not communicating, connected and ready to log in (a blinking arrow), or logged in and charged (a solid arrow). Click here to view Settings &amp; Status.</td>
<td></td>
</tr>
<tr>
<td>CAPS Shows status of the <code>shift</code>, <code>ctrl</code>, and <code>CAPS</code> keys.</td>
<td></td>
</tr>
<tr>
<td>RAD Angle Mode - Shows an abbreviation of the angle mode (Degrees, Radians, or Gradians) in effect. Hover the pointer over the indicator to see the full name. <strong>Note:</strong> Click the indicator to toggle between RAD and DEG modes.</td>
<td></td>
</tr>
<tr>
<td>Settings &amp; Status - Shows an indicator of the current charge level of the battery. Hover the pointer over the indicator to read the status as a percent. Click the icon to open the Settings &amp; Status menu.</td>
<td></td>
</tr>
<tr>
<td>Close document - Click the icon to close the current document. If information is unsaved, save or discard when prompted.</td>
<td></td>
</tr>
</tbody>
</table>

**Using Hints**

**Hints** are quick tips available throughout the software on the handheld. There are several easy ways to access Hints:

- Press `ctrl` `fn`.
- Some dialog boxes contain a question mark icon. Click this icon to open Hints for that task.

To scroll through the Hints, use the Touchpad or arrow keys:

- To page down, press `ctrl` `3`.
- To page up, press `ctrl` `9`.
- To go to the end of the Hints file, press `ctrl` `1`.
- To go back to the beginning of the file, press `ctrl` `7`.

**Using Keyboard Shortcuts**

Use the following keyboard shortcuts to perform common functions. You can also perform all functions by selecting the options from menus.
## Getting Help

<table>
<thead>
<tr>
<th>Operation</th>
<th>Key Combination</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open Hints</td>
<td>\text{ctrl + F4}</td>
</tr>
</tbody>
</table>

## Editing Text

<table>
<thead>
<tr>
<th>Operation</th>
<th>Key Combination</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cut</td>
<td>\text{ctrl + X}</td>
</tr>
<tr>
<td>Copy</td>
<td>\text{ctrl + C}</td>
</tr>
<tr>
<td>Paste</td>
<td>\text{ctrl + V}</td>
</tr>
<tr>
<td>Undo</td>
<td>\text{ctrl + Z}</td>
</tr>
<tr>
<td>Redo</td>
<td>\text{ctrl + Y}</td>
</tr>
</tbody>
</table>

## Python Editor and Shell

Add a new line after the current line.

### English: Change key to include appropriate accent
### Chinese: Insert character

## Inserting Characters and Symbols in a document

<table>
<thead>
<tr>
<th>Task</th>
<th>Key Combination</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display character/symbol palette</td>
<td>\text{ctrl + 1}</td>
</tr>
<tr>
<td>Underscore</td>
<td>\text{ctrl + 2}</td>
</tr>
<tr>
<td>Display math template palette</td>
<td>\text{alt + [z]}</td>
</tr>
<tr>
<td>Backslash (\ )</td>
<td>\text{shift + 4}</td>
</tr>
<tr>
<td>Manual data capture point</td>
<td>\text{ctrl + .}</td>
</tr>
<tr>
<td>Clear</td>
<td>\text{ctrl + del}</td>
</tr>
<tr>
<td>Caps Lock</td>
<td>\text{ctrl + shift}</td>
</tr>
<tr>
<td>Store</td>
<td>\text{ctrl + var}</td>
</tr>
<tr>
<td>Feature</td>
<td>Shortcut</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>----------</td>
</tr>
<tr>
<td>Square brackets</td>
<td>ctrl (</td>
</tr>
<tr>
<td>Curly brackets</td>
<td>ctrl )</td>
</tr>
<tr>
<td>Display Trig symbol palette</td>
<td>trig</td>
</tr>
<tr>
<td>Equals symbol</td>
<td>=</td>
</tr>
<tr>
<td>Display pi symbols palette (π, /, θ, and so on)</td>
<td>π&gt;</td>
</tr>
<tr>
<td>Display equality/inequality palette (&gt;, &lt;, ≠, ≤, ≥, and</td>
<td>ctrl =</td>
</tr>
<tr>
<td>Display marks and letter symbols palette (? ! $ ^ % : ; _ )</td>
<td>?!&gt;</td>
</tr>
<tr>
<td>Square root</td>
<td>ctrl x²</td>
</tr>
<tr>
<td>log</td>
<td>ctrl log</td>
</tr>
<tr>
<td>In</td>
<td>ctrl e^x</td>
</tr>
<tr>
<td>ans</td>
<td>ctrl (-)</td>
</tr>
</tbody>
</table>

**Managing Documents**

<table>
<thead>
<tr>
<th>Command</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open document menu</td>
<td>doc&gt;</td>
</tr>
<tr>
<td>Open document</td>
<td>ctrl O</td>
</tr>
<tr>
<td>Close document</td>
<td>ctrl W</td>
</tr>
<tr>
<td>Create new document</td>
<td>ctrl N</td>
</tr>
<tr>
<td>Insert new page</td>
<td>ctrl I</td>
</tr>
<tr>
<td>Select application</td>
<td>ctrl K</td>
</tr>
<tr>
<td>Save current document</td>
<td>ctrl S</td>
</tr>
<tr>
<td></td>
<td>ctrl %</td>
</tr>
</tbody>
</table>

**Navigation**
<table>
<thead>
<tr>
<th>Top of page</th>
<th>(\text{ctrl} \ 7)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Python Editor and Shell:</strong> Moves cursor to the beginning of the first line in the program.</td>
<td></td>
</tr>
<tr>
<td>End of page</td>
<td>(\text{ctrl} \ 1)</td>
</tr>
<tr>
<td><strong>Python Editor and Shell:</strong> Moves cursor to the end of the last line in the program.</td>
<td></td>
</tr>
<tr>
<td>Page Up</td>
<td>(\text{ctrl} \ 9)</td>
</tr>
<tr>
<td>Page Down</td>
<td>(\text{ctrl} \ 3)</td>
</tr>
<tr>
<td>Up a level in the hierarchy</td>
<td>(\text{ctrl} \ ▲)</td>
</tr>
<tr>
<td>Down a level in the hierarchy</td>
<td>(\text{ctrl} \ ▼)</td>
</tr>
<tr>
<td>Context menu for selection</td>
<td>(\text{menu})</td>
</tr>
<tr>
<td>Extends selection in direction of arrow</td>
<td>(\text{shift}) Any arrow</td>
</tr>
<tr>
<td><strong>Python Editor and Shell:</strong> Indents text on the current line or selected lines or navigates between inline prompts</td>
<td>(\text{tab})</td>
</tr>
</tbody>
</table>

**Navigating in Documents**

| Displays previous page | \(\text{ctrl} \ ▼\) |
| Displays next page | \(\text{ctrl} \ ▲\) |
| Displays Page Sorter | \(\text{ctrl} \ ▼\) |
| Exits Page Sorter | \(\text{ctrl} \ ▼\) |
| Switch between applications on a split page | \(\text{ctrl} \ \text{tab}\) |
| Moves focus backward within page | \(\text{shift} \ \text{tab}\) |
| **Python Editor and Shell:** Dedents text on the current line or selected lines or navigates backwards between inline prompts |  |
### Wizards and Templates

<table>
<thead>
<tr>
<th>Action</th>
<th>Key Sequence</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add a column to a matrix after the current column.</td>
<td><code>⌘ shift ←</code></td>
</tr>
<tr>
<td>Add a row to a matrix after the current row.</td>
<td><code>←</code></td>
</tr>
<tr>
<td><strong>Python Editor and Shell:</strong> Add a new line after the current line.</td>
<td></td>
</tr>
<tr>
<td>Integration template</td>
<td><code>⌘ shift +</code></td>
</tr>
<tr>
<td>Derivative template</td>
<td><code>⌘ shift -</code></td>
</tr>
<tr>
<td>Math template palette</td>
<td><code>⌘ [</code> or <code>⌘ return</code></td>
</tr>
<tr>
<td>Fraction template</td>
<td><code>⌘ /</code></td>
</tr>
</tbody>
</table>

### Modifying Display

<table>
<thead>
<tr>
<th>Action</th>
<th>Key Sequence</th>
</tr>
</thead>
<tbody>
<tr>
<td>Increase contrast</td>
<td><code>⌘ +</code></td>
</tr>
<tr>
<td>Decrease contrast</td>
<td><code>⌘ -</code></td>
</tr>
<tr>
<td>Power off</td>
<td><code>⌘ </code> on`</td>
</tr>
</tbody>
</table>

### Application-Specific Shortcuts

<p>| Notes/Program Editor/Python Editor: Select all                      | <code>⌘ A</code>  |
| <strong>Press-to-Test:</strong> Select all items in the dialog                   |         |
| <strong>Program Editor/Python Editor:</strong> Check syntax and store           | <code>⌘ B</code> |
| <strong>Program Editor/Python Editor:</strong> Find                              | <code>⌘ F</code> |
| Geometry/Graph: Hide/Show Entry Line                                 | <code>⌘ G</code> |
| Lists &amp; Spreadsheet/Program Editor/Python Editor: Go To            |         |
| <strong>Program Editor/Python Editor:</strong> Find and Replace                 | <code>⌘ H</code> |
| Calculator/Program Editor/Python Editor and Shell: Beginning of line | <code>⌘ 8</code> |</p>
<table>
<thead>
<tr>
<th>Task</th>
<th>Shortcuts</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Calculator/Program Editor/Python Editor and Shell:</strong></td>
<td></td>
</tr>
<tr>
<td>End of line</td>
<td>ctrl 2</td>
</tr>
<tr>
<td><strong>Notes:</strong> Insert math expression box</td>
<td>ctrl M</td>
</tr>
<tr>
<td><strong>Notes:</strong> Insert chemical equation box</td>
<td>ctrl E</td>
</tr>
<tr>
<td>Open the Scratchpad</td>
<td></td>
</tr>
<tr>
<td><strong>Lists &amp; Spreadsheet:</strong> Recalculate</td>
<td></td>
</tr>
<tr>
<td><strong>Program Editor:</strong> Check syntax, store program and paste program name in Calculator (after clearing current line in Calculator)</td>
<td></td>
</tr>
<tr>
<td><strong>Python Editor:</strong> Check syntax, save program and execute in Python Shell</td>
<td></td>
</tr>
<tr>
<td><strong>Python Shell:</strong> Rerun last program</td>
<td></td>
</tr>
<tr>
<td><strong>Geometry/Graphs/Lists &amp; Spreadsheet:</strong> Add Function Table</td>
<td></td>
</tr>
<tr>
<td><strong>Program Editor/Python Editor and Shell:</strong> Add/remove comment symbol</td>
<td></td>
</tr>
<tr>
<td>Group/Ungroup applications on a page</td>
<td>ctrl 4 / ctrl 6</td>
</tr>
</tbody>
</table>
Using the Scratchpad

The Scratchpad is a feature of the TI-Nspire™ CX handheld that lets you quickly:

- Evaluate math expressions.
- Graph functions.

Opening and Closing the Scratchpad

- From the Home screen, press \[ \text{fn} \] to open the Scratchpad.

  The first time you open the Scratchpad, a blank page opens with the Calculator active.

- Press \[ \text{fn} \] to alternate between the Calculate and Graph pages.

- Press \[ \text{menu} \] to see the Scratchpad Calculate or Scratchpad Graph menu. These menus are subsets of the TI-Nspire™ menus for the Calculator and Graphs applications. For complete listings of those menus, see the documentation for those applications.

- Press \[ \text{esc} \] to close the Scratchpad.

Calculating with Scratchpad

From the Scratchpad Calculate page, enter a math expression on the entry line, and then press \[ \text{enter} \] to evaluate the expression. Expressions are displayed in standard mathematical notation as you enter them.

Each evaluated expression and result becomes part of the Scratchpad history, displayed above the entry line.

Entering Simple Math Expressions

**Note:** To enter a negative number, press \[ (-) \] and then type the number.

\[
\frac{2^8 \cdot 43}{12}
\]

Suppose you want to evaluate \(\frac{2^8 \cdot 43}{12}\):

1. Select the entry line in the work area.
2. Type \(2 \, \wedge \, 8\) to begin the expression.

\[
2^8
\]

3. Press \[ \text{up arrow} \] to return the cursor to the baseline, and then complete the expression by typing:

\[
\times \, 43 \, \div \, 12
\]

\[
2^8 \cdot 43/12
\]
4. Press \textbf{enter} to evaluate the expression.

The expression is displayed in standard mathematical notation, and the result is displayed on the right side of the page.

\[
\frac{2^8.43}{12} \quad 2752 \quad \frac{2752}{3}
\]

\textbf{Note:} You can force a decimal approximation in a result by pressing \textbf{ctrl enter} instead of \textbf{enter}.

\[
\frac{2^8.43}{12} \quad 917.333
\]

\textit{Pressing \textbf{ctrl enter} forces the approximate result.}

\textbf{Note:} Results formatting can also be adjusted in settings. For more information about customizing settings, see \textit{Configuring Handhelds}.

\textbf{Inserting Items from the Catalog}

You can use the Catalog to insert functions and commands, symbols, and expression templates into the entry line.

1. Press \textbf{CATALOG} to open the Catalog. By default, the first tab is displayed, which lists all commands and functions in alphabetical order.

2. If the function you are inserting is visible in the list, select it and press \textbf{enter} to insert it.

3. If the function is not visible:
   a) Press a letter key to jump to the entries that begin with that letter.
   b) Press \textbf{▼} or \textbf{▲} as necessary to highlight the item you are inserting.
   c) Click a numbered tab to list functions by category: math functions, symbols, math templates, library objects, and value for standard measurement units.
   d) Press \textbf{enter} to insert the item into the entry line.

\textbf{Using an Expression Template}

Templates help you enter matrices, piecewise functions, systems of equations, integrals, derivatives, products, and other math expressions.
For example, suppose you want to evaluate \[ \sum_{n=3}^{7} (n) \]

1. Press \[ \text{[H]t] } \] to open the Template palette.

2. Select \[ \text{[B]} \] to insert the algebraic sum template.

   The template appears on the entry line with small blocks representing elements that you can enter. A cursor appears next to one of the elements to show that you can type a value for that element.

   \[ \sum_{i=3}^{7} (\square) \]

3. Use the arrow keys to move the cursor to each element’s position, and type a value or expression for each element.

   \[ \sum_{n=3}^{7} (n) \]

4. Press \[ \text{[enter]} \] to evaluate the expression.

   \[ \sum_{n=3}^{7} (n) = 25 \]

**Inserting Expressions Using a Wizard**

You can use a wizard to simplify entering some expressions. The wizard contains labeled boxes to help you enter the arguments in the expression.

For example, suppose you want to fit a \( y = mx + b \) linear regression model to the following two lists:

\[ \{1,2,3,4,5\} \]
\[ \{5,8,11,14,17\} \]

1. Press \[ \text{[G]} \text{[1]} \] to open the Catalog and show the alphabetic list of functions.

2. Click inside the list, and then press \[ \text{[L]} \] to jump to the entries that begin with “L.”
3. Press ▼ as necessary to highlight LinRegMx.

4. If the Wizards On option is not checked, press tab tab to highlight Wizards On.

5. Press enter to change the setting.

6. Press tab tab to highlight LinRegMx again.

7. Press enter.

   A wizard opens, giving you a labeled box to type each argument.

8. Type \{1, 2, 3, 4, 5\} as X List.

9. Press tab to move to the Y List field.

10. Type \{5, 8, 11, 14, 17\} as Y List.
11. If you want to store the regression equation in a specific variable, press \[\text{tab}\], and then replace \textit{Save RegEqn To} with the name of the function variable (f1 through f99).

12. Click \textit{OK} to close the wizard and insert the expression into the entry line.

The expression is inserted along with statements to copy the regression equation and display the variable \textit{stat.results}, which will contain the results.

LinRegMx \{1,2,3,4,5\},\{5,8,11,14,17\},1: CopyVar stat.RegEqn,f1: stat.results

The Scratchpad then displays the \textit{stat.results} variables.

![Scratchpad example]

\textbf{Note:} You can copy values from the \textit{stat.results} variables and paste them into the entry line.

\textbf{Viewing the History}

Each evaluated expression and result becomes part of the Scratchpad history, displayed above the entry line.

- Press \(\uparrow\) or \(\downarrow\) to scroll through the history.

![Scratchpad history]

\textbf{Copying a History Item to the Entry Line}

You can quickly copy an expression, subexpression, or result from the history into the entry line.

1. Press \(\uparrow\) or \(\downarrow\) to move through the history and select the item that you want to copy.
2. Optionally, select part of the expression or result by using \( \text{shift} \) in combination with the arrow keys.

\[
\text{approx} \begin{bmatrix} 2^8 \cdot 12 \\ 42 \end{bmatrix} = 73.1428571429
\]

3. Press \( \text{enter} \) to copy the selection and insert it into the entry line.

\[
\sqrt{\frac{2^8 \cdot 12}{42}} = \frac{16 \cdot \sqrt{14}}{7}
\]

### Clearing the History

When you clear the history, all variables and functions defined in the history retain their current values. If you clear the history by mistake, use the undo feature.

- From the Actions menu, click **Clear History**.
  - or —
  - Press menu [1 5].

All expressions and results are removed from the history.

### Editing Scratchpad Expressions

Although you cannot edit a Scratchpad Calculate expression in the history, you can copy all or part of an expression from the history and paste it to the entry line. You can then edit the entry line.

#### Inserting Elements into the Entry Line

1. Press \( \text{tab}, \downarrow, \uparrow, \text{ or } \downarrow \) to position the cursor in the expression.
   
   The cursor moves to the closest valid position in the direction that you press.

2. Type the elements or insert them from the Catalog.

#### Selecting Part of an Expression

You can delete, cut, or copy a selected part of an expression.

1. Press \( \downarrow, \uparrow, \text{ or } \downarrow \) to move the cursor to a starting point in the expression.

2. Press and hold \( \text{shift} \) and press \( \downarrow, \uparrow, \text{ or } \downarrow \) to select.
   - To delete the selection, press \( \text{del} \).

   - To cut the selection to the Clipboard, press \( \text{ctrl X} \).

   - To copy the selection to the Clipboard, press \( \text{ctrl C} \).
To paste the selection to a new entry line in Scratchpad, press \texttt{ctrl V}.

**Graphing with the Scratchpad**

1. Press \texttt{\textasciitilde} to open the Scratchpad Graph page if it is not already open.

   By default, the entry line is displayed. The entry line displays the required format for typing a relation. The default graph type is Function, so the form \( f1(x) = \) is displayed.

   If the entry line is not shown, press \texttt{Ctrl + G} or press \texttt{menu 2 3} to display the entry line and type an expression to graph.

2. Press \texttt{menu} > \texttt{Graph Entry/Edit} and select a graph type.

   For example:
   - To graph an equation for a circle, press \texttt{menu} > \texttt{Graph Entry/Edit} > \texttt{Equation} > \texttt{Circle} > \((x-h)^2 + (y-k)^2 = r^2\) or press \texttt{menu 3 2 3 1}. Fill in the equation and press \texttt{enter} to draw the circle.
   - To graph a function, press \texttt{menu} > \texttt{Graph Entry/Edit} > \texttt{Function} or press \texttt{menu 3 1}.

   The entry line changes to display the expression format for the specified graph type. You can specify multiple relations of each graph type.

3. Type an expression and any other parameters required for the graph type.

4. Press \texttt{enter} to graph the relation, or press \texttt{\textasciitilde} to add another relation. If necessary, you can use press \texttt{menu 4} to choose a tool on the \texttt{Window/Zoom} menu and adjust the viewing area.

   When you graph the relation, the entry line disappears to show an uncluttered view of the graph. If you select or trace a plot, the relation that defines the plot is displayed on the entry line. You can modify a plot by defining a relation or by selecting and changing the graph.

   As you graph multiple plots, the defining relation is displayed for each. You can define and graph a maximum of 99 relations of each type.

5. Use the \texttt{menu} key to explore and analyze the relation to:
   - Trace the relation.
   - Find points of interest.
   - Assign a variable in the expression to a slider.

---

*Using the Scratchpad* 21
Viewing the Table

- To display a table of values corresponding to the current plots, press menu > Table > Split-screen Table (menu 7 1).

- To hide the table, click the graph side of the split screen, and then press menu > Table > Remove Table (menu 7 2). You can also press Ctrl + T.

- To resize columns, click the table and press menu > Actions > Resize (menu 1 1).

- To delete a column, edit an expression, or edit table settings, click the table and press menu > Table (menu 2).

Changing the Appearance of the Axes

As you work with graphs, the Cartesian axes are displayed by default. You can change the appearance of the axes in the following ways:

1. Press menu 4 and choose the Zoom tool to use.
2. Select the axes and press ctrl menu 2 to activate the Attributes tool.
   a) Press ▲ or ▼ to move to the attribute to change. For example, choose the end style attribute.
   b) Press ◄ or ► to choose the style to apply.
   c) Change any other attributes of the axes as required for your work, and then press enter to exit the attributes tool.
3. Adjust the axes scale and tic mark spacing manually.
   a) Click and hold one tick mark, and move it on the axis. The spacing and number of tic marks increases (or decreases) on both axes.
   b) To adjust the scale and tic mark spacing on a single axis, press and hold shift, and then grab and drag a tic mark on that axis.
4. Change axis end values by double-clicking them and typing new values.
5. Adjust the location of the axes. To move the existing axes without resizing or rescaling them, click in and drag an empty region of the screen until the axes are in the desired location.
6. Change the axes’ scales by pressing \( \text{menu} \) > Window/Zoom > Window Settings \( (\text{menu} \ 4 \ 1) \).

Type the values of your choice over the current values for x-min, x-max, y-min, y-max, Xscale, and Yscale and click OK.

7. Press \( \text{menu} \) > View > Hide Axes \( (\text{menu} \ 2 \ 1) \) to hide or show the axes.
   - If the axes are shown on the page, selecting this tool hides them.
   - If the axes are hidden on the page, selecting this tool redispays them.

Tracing a Plot

Graph Trace moves through the points of a graphed function, parametric, polar, sequence, or scatter plot. To enable the trace tool:

1. Press \( \text{menu} \) > Trace > Graph Trace \( (\text{menu} \ 5 \ 1) \) to move across the plot in Trace mode.

2. (Optional) To change the trace step increment for tracing, press \( \text{menu} \ 5 \ 3 \).

   After you type a different step increment, the Graph Trace tool moves across the graph in steps of that size.

3. Use Graph Trace to explore a plot in the following ways:
   - Move to a point and hover to move the trace cursor to that point.
   - Press \( \downarrow \) or \( \uparrow \) to move from point to point on the function’s graph. The coordinates of each point traced are displayed.
   - Press \( \leftarrow \) or \( \rightarrow \) to move from one plot to another. The point’s coordinates update to reflect the new location of the trace. The trace cursor is positioned on the point of the new graph or plot with the closest x value to the last point identified on the previously traced function or graph.
   - Type a number and press \( \text{enter} \) to move the trace cursor to the point on the plot with independent coordinates nearest the typed value.
   - Create a persistent point that remains on the graph by pressing \( \text{enter} \) when the trace point reaches the point you want to label. The point remains after you exit Graph Trace mode.
Notes:

- The string *undef* is displayed instead of a value when you move over a point that is not defined for the function (a discontinuity).
- When you trace beyond the initially visible graph, the screen pans to show the area being traced.

4. Press [ESC] or choose another tool to exit Graph Trace.

**Finding Points of Interest**

You can use the tools on the Analyze Graph menu to find a point of interest in a specified range of any graphed function. Choose a tool to find zero, the minimum or maximum, the point of intersection or inflection, or the numeric derivative (dy/dx) or Integral on the graph.

1. Select the point of interest that you want to find on the Analyze Graph menu. For example, to find a zero, press [menu 6 1].

<table>
<thead>
<tr>
<th>Tool</th>
<th>non-CAS and Exact Arithmetic</th>
<th>CAS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Zero</td>
<td>[menu 6 1]</td>
<td>[menu 6 1]</td>
</tr>
<tr>
<td>Minimum</td>
<td>[menu 6 2]</td>
<td>[menu 6 2]</td>
</tr>
<tr>
<td>Maximum</td>
<td>[menu 6 3]</td>
<td>[menu 6 3]</td>
</tr>
<tr>
<td>Intersection</td>
<td>[menu 6 4]</td>
<td>[menu 6 4]</td>
</tr>
<tr>
<td>Inflection</td>
<td>Not applicable</td>
<td>[menu 6 5]</td>
</tr>
<tr>
<td>dy/dx</td>
<td>[menu 6 5]</td>
<td>[menu 6 6]</td>
</tr>
<tr>
<td>Integral</td>
<td>[menu 6 6]</td>
<td>[menu 6 7]</td>
</tr>
<tr>
<td>Analyze Conics</td>
<td>[menu 6 7]</td>
<td>[menu 6 8]</td>
</tr>
</tbody>
</table>

The icon for the selected tool is displayed at the top left on the work area. Point to the icon to view a tooltip about how to use the selected tool.

2. Click the graph you want to search for the point of interest, and then click a second time to indicate where to start the search for the point.

   The second click marks the lower bound of the search region and a dotted line is displayed.

   **Note:** If you are finding the derivative (dy/dx), click the graph at the point (numeric value) to use for finding the derivative.

3. Press ▼ or ▲ to move the dotted line that marks the search region, and then click the point at which you want to stop the search (upper bound of the search region).
4. Press `enter` at the point to start the search. The tool shades the range.

If the search region you specified includes the point of interest, a label for the point is displayed. If you change a graph that has points of interest identified, be sure to check for changes in points of interest. For example, if you edit the function on the entry line or manipulate a plot, the point where the graph intersects zero can change.

The labeled points of interest remain visible on the graph. You can exit the tool by pressing `esc` or choosing another tool.

**Working with Variables in the Scratchpad**

Scratchpad variables are shared between Scratchpad Calculate and Scratchpad Graph, but not with any TI-Nspire™ documents. If you use the same name for a Scratchpad variable and a variable in a document, no conflict occurs unless you attempt to copy expressions between documents and the Scratchpad.

**Saving the Scratchpad Contents**

You can save the Scratchpad Calculate page, the Scratchpad Graph page, or both as a TI-Nspire™ document.

1. Press `doc•`, and then select **Save to Document** (`doc• A`).

2. Press `enter`.

   The Save to Document dialog box opens.

3. Select the page or pages to save.
4. If a document is open, select either New or Current document.

5. Click Save.
   - If you selected to save to a current (open) document, the Scratchpad pages are added to the document.
   - If you selected to save the Scratchpad pages to a new document, the pages are converted to an unsaved document. To save the document:
     - Press \[\text{doc} \] > Save. The Save As dialog box opens.
     - Type a name for the document.
     - Select Save to save the new document.

**Clearing Scratchpad Contents**

Complete the following steps to delete the calculations and graphing work from the Scratchpad application.

1. Press \[\text{doc} \] > Clear Scratchpad (\[\text{doc} \ \text{B} \]).

2. Press enter to delete the Scratchpad contents.
Working with Documents on TI-Nspire™ CX II Handhelds

All of the work you do with a TI-Nspire™ CX II handheld is contained in one or more TI-Nspire™ documents, which you can share with other handheld users and with those using the computer software.

- Each document is divided into at least one, and up to 30, problems.
- Each problem contains at least one, and up to 50, pages.
- Each page can be divided into as many as four work areas.
- Each work area can contain any of the TI-Nspire™ applications (Calculator, Graph, Geometry, Lists & Spreadsheet, Data & Statistics, Notes, and Vernier DataQuest™).

Opening a Document

1. From the Home screen, select Browse.
   —or—
   
   Press 2.

   The file manager opens.

   ![File Manager]

   2. Navigate to the file you want to open.
      - Press ▼ to highlight the document name, and then press  or enter to open the document.
      - If the file is in a folder, press ▼ to highlight the folder, and then press  or enter to open the folder.

   3. Press doc to open the Documents menu to access options for working with the open document.

Creating a New Document

1. From the Home screen, select New.
   —or—
Press $1$.

You can also press $ctrl + N$.

A new document opens with a list of applications.

![List of applications](image)

**Note:** The tab at the top left of the screen indicates that this is the first page of the first problem.

2. Use $\downarrow$ and $\uparrow$ to highlight the application you want to add to the page, and then press enter to open the page.

**Saving Documents**

To save the document in the My Documents folder:

1. Press $doc\leftarrow$ to open the Documents menu, and then select **File > Save**.

**Note:** You can also press $doc + 1 + 4$ or $ctrl + S$ to save a document.

The Save As dialog box opens.

![Save As dialog box](image)
If you are saving the document for the first time, you will be asked which folder to save it to, and what to name the document. The default folder is My Documents.

2. Type a name for the document.
3. Click **Save** to save the document in the My Documents folder.

### Saving a Document in a Different Folder

To save the document in a different folder:

1. From an open document, press `doc` + 1 5. The Save As dialog box opens.

2. Press `shift` + `tab` to navigate to the list of existing folders. The first folder in the list is selected.

3. Use the ▼ and ▲ to scroll through the list of folders.

4. To select and open a folder, press `.`.

5. Type a name for the document.

6. Click **Save** to save the document in the selected folder.

### Saving a Document in a New Folder

To save the document in a new folder:

1. From an open document, press `doc` + 1 5. The Save As dialog box opens.

2. Press `tab` until the New Folder icon is highlighted, and then press `enter` to create a new folder.

   The new folder is added to the bottom of the list of existing folders. By default, the folder name is “Folder1.”
3. Type a name for the new folder, and then press **enter** to save.

4. Press **enter** again to open the folder.
   
   The File Name field becomes active.

5. Type a name for the document.

6. Click **Save** to save the document in the new folder.

**Working with Applications**

Options for working with applications include:

- Creating a new document and selecting an application
- Adding a new page and application to an open document
- Adding multiple applications to a page in a document

**Adding an Application**

There are multiple ways to add an application to a page:

- When creating a new document, use the Touchpad or corresponding numbers to select an application from the list of applications.

- To add a new page and application to an open document, press **ctrl** **doc** and then select an application from the list.

For example, press **2** to add the Graph application to the page. The application opens in the work area.

You can also press **on**, and then select an application from the Home screen by clicking one of the following application icons:

| Calculator | X + |
Using Multiple Applications on a Page

You can add up to four applications to each page.

When you create a new document, it contains space to add one application. If you need to add more than one application to a page, you can change the layout to accommodate as many as four applications.

You can choose a standard layout, provided as a menu item, or you can customize a layout to suit your needs.

Choosing a Standard Page Layout

1. Press \texttt{doc} 5 2 to display layout options.

2. Press the number that corresponds to the layout you want.

   For example, press 2 to create a two-pane layout, divided vertically on the page.
3. Press \( \text{ctrl} \text{tab} \) to move between panes. Bold lines around the pane indicate that the pane is active.

4. Press \( \text{menu} \), and then press the number of the application you want to add the new pane. For example, press 4 to add the Lists & Spreadsheet application.

**Note:** If you need to change the layout of the page to add or delete applications, you can do so at any time. When deleting an application, select the application to be deleted first.

**Creating a Custom Page Layout**

If the standard layouts do not meet your needs, you can customize the space allotted to applications on a page.

1. Press \( \text{doc} \text{5} \) to display layout options.
2. Press 1 to select the custom split option.

The standard layout is displayed with a divider between the application panes. Use the arrows (➡️) in the middle of the divider to adjust the size of the panes.

3. Press ↕️, ←, →, or ➡️ to move the divider to adjust the height or width of the panes in the layout.

4. Press + or − to select a defined layout:
   - Pressing − returns to a full page layout.
   - Pressing + once switches layout from a vertical layout to a horizontal layout. Press − to go back to a vertical layout.
   - Pressing + twice adds a third pane to the page. Pressing + multiple times enables you to choose between a vertical and horizontal page layout with three panes.
   - Pressing + five times adds a fourth pane to the page. Press − to cycle through the previous layout options.

5. Press ⏎️ or enter to accept the layout dimensions.
6. Press \[\text{ctrl}\] \[\text{tab}\] to move between panes. Bold lines around the pane indicate that the pane is active.

**Swapping Applications on a Page**

If you want to change the position of applications on a page with multiple applications, you can do so by “swapping” the positions of two applications.

1. Press \[\text{doc} \ 5\] Page Layout \[4\] Swap Application.

   The selected application is surrounded by a heavy, flashing black border, and the Swap App cursor \(\textcircled{S}\) is displayed on the screen.

   **Note:** On a two-pane page layout, the selected application automatically swaps position with the opposite pane. Press \[\text{esc}\] or \[\text{enter}\] to complete the swap.

2. Press \[\uparrow, \downarrow, \leftarrow, \rightarrow\] to position the cursor over the application you are targeting to swap.

3. Press \[\text{esc}\] or \[\text{enter}\] to complete the swap.

   **Note:** Press \[\text{esc}\] to cancel the swap.

**Grouping Applications**

To group up to four application pages into a single page:

1. Select the first page in the series.

2. From the **Document** menu, select **Page Layout > Group**.

   Press \[\text{doc} \ 5 \ 7\].

   The next page is grouped with the first page. The page layout automatically adjusts to display all the pages in the group.

**Ungrouping Pages**

To ungroup the pages:

1. Select the grouped page.

2. From the **Document** menu, select **Page Layout > Ungroup**.

   —or—

   Press \[\text{doc} \ 5 \ 8\].

   The material becomes individual pages for each application.

**Deleting an Application from a Page**

1. Click the application you want to delete.

2. From the **Document** menu, select **Page Layout > Delete Application**.

   —or—
Press doc 5 5.

The selected application is deleted.

If you want to undo the delete, press Ctrl-Z.

**Using the Application Menu**

The Application menu enables you to select tools for working with a specific application. Each application has a unique menu.

**Using the Application Menu**

1. From a blank page, press menu to display the Application menu.

   The menu displays applications that you can add to the page.

2. Press the number of the application you want to add to the page. For example, press 4 to add the Lists & Spreadsheet application.

3. Press menu to display the Application menu, which lists the options for working with the current application.

   The example below displays the Application menu for the Lists & Spreadsheet application.

---

---
**Context Menus**

Context menus display options that are specific to the selected object or the current cursor location.

**Using the Context Menu**

- To access a context-sensitive menu from an application, press `ctrl` + `menu`.

In the example below, the context menu displays options available for the selected cell in Lists & Spreadsheet.

![Context Menu Example](image)

**Working with Problems and Pages**

The options on the **Documents** menu let you:

- Save a document
- Access edit functions such as undo, redo, cut, copy, paste, and delete
- Move between pages and open the page sorter view for documents with multiple pages
- Modify page layout, insert pages or problems, delete pages, and change settings
- Add problems, pages, and applications to open documents
- Access page layout options

**Adding a Problem to a Document**

Adding problems to a document enables you to reuse variable names. A document can contain as many as 30 problems. To add a new problem:

1. Press `doc` + `4` + `1` to open the Insert options.
A new problem with one page is added to the document. The tab at the top left of the screen indicates that this is the first page of the second problem.

2. Press \textbf{menu} to open the Application menu, and then, press the number corresponding to the application you want to add to the new page.

\textbf{Viewing and Reordering Pages in a Document}

The Page Sorter displays all of the problems in your document and all pages within each problem in thumbnail format. You can use the Page Sorter to rearrange and delete pages, copy a page from one problem and paste it into another, and apply templates to pages.

\textbf{Viewing Multiple Pages with the Page Sorter}

Although the handheld typically displays the pages in your document one at a time, the Page Sorter lets you see all of the problems in your document and all pages within each problem in thumbnail format. You can use the Page Sorter to rearrange and delete pages, and copy a page from one problem and paste it in another.

\textbf{Opening the Page Sorter from a Document}

\begin{itemize}
  \item Press $\texttt{ctrl}$ $\uparrow$.
\end{itemize}
The Page Sorter screen displays all of the problems and pages in the current document.

Reordering Pages in a Problem

Use the Page Sorter (press $\text{ctrl}\ 
\uparrow$) to move a page within a problem with multiple pages:

1. Press the $\uparrow$ or $\downarrow$ key to select the page you want to move.
   A heavy border around the page indicates that it is selected.

2. Either press and hold $\text{ctrl}$ or press $\text{ctrl} \text{shift}$ until the grab cursor is displayed.

3. Press $\uparrow$, $\downarrow$, $\uparrow$, or $\downarrow$ to move the page to the desired position.

4. Press $\text{esc}$ or $\text{enter}$ to finish the move.

   **Note:** You can press $\text{esc}$ to cancel.

The page moves to the new location within the problem, and the counter adjusts accordingly.
Copying a Page to Another Problem

To copy a page from one problem to another in the same document:

1. Press \( \text{ctrl} \) to open Page Sorter.
2. Press \( \downarrow, \uparrow, \Delta, \) or \( \nabla \) to select the page you want to copy.
   A heavy border around the page indicates that it is selected.
3. Press \( \text{ctrl} \) \( C \) to copy the page.
4. Press \( \downarrow, \uparrow, \Delta, \) or \( \nabla \) to select the desired position in the problem where you will paste the page. The copied page will be placed after the page you select.
5. Press \( \text{ctrl} \) \( V \) to paste the page in the new location.
   The page is copied to the new location within the problem, and the counter adjusts accordingly.

Note: If the page contains variables with the same names as the new problem, a conflict may occur. Rename the variables if necessary.

Copying a Page to Another Document

To copy a page from one document to another document:

1. Press \( \text{ctrl} \) \( \uparrow \) to open the Page Sorter.
2. Press \( \downarrow, \uparrow, \Delta, \) or \( \nabla \) to select the page you want to copy.
   A heavy border around the page indicates that it is selected.
3. Press \( \text{ctrl} \) \( C \) to copy the page.
4. Press \( \text{ctrl} \) \( 2 \) to open My Documents.
5. Press \( \uparrow \) and \( \nabla \) to highlight the folder containing the document you want to copy the page to.
6. Press \( \uparrow \) to open the folder.
Working with Documents on Ti-Nspire™ CX II Handhelds

—or—

Press [menu 3].

7. Press the ▲ and ▼ keys to highlight the document.
8. Press [e] or [enter] to open the document.
10. Press [↓], [↑], [▲], or [▼] to move the page to the desired position in the document.
11. Press [ctrl V] to paste the page in the new location.

The page moves to the new location within the problem, and the counter adjusts accordingly.

Copying, Pasting, and Deleting Problems

You can copy and paste a single problem from one location to another within the same document or a different document. You can also delete a problem from the document.

Copying and Pasting a Problem

To copy and paste a problem:

1. Open the Page Sorter.

Press [ctrl ▲].

—or—

Press [doc ▼ 3 3].

2. Select the problem. If there are multiple problems, you can press [menu 2] to collapse the Page Sorter to list the problems by number and title only.
3. Press [ctrl C].
4. Go to the location where you want the problem to appear.
5. Press \texttt{ctrl} \texttt{V}.

A duplicate problem is placed in the new location.

**Deleting a Problem**

To delete a problem from the document:

1. Select the problem from the Page Sorter.
2. Press \texttt{ctrl} \texttt{X}.

The problem is deleted from the document.

**Renaming a Problem**

To rename a problem:

1. With the document active, open the Page Sorter.
   
   Press \texttt{ctrl} \texttt{~}.

2. Select the problem name.
3. Press \texttt{ctrl} \texttt{menu}.
4. Select \texttt{7 Rename} and type the name.
5. Press \texttt{ctrl} \texttt{S} to save the change.

**Adding a Page to a Problem**

Each problem can contain up to 50 pages. To add a new page to a problem:

- Press \texttt{ctrl} \texttt{doc} or \texttt{ctrl} \texttt{I} to add a blank page and select an application.

  —or—

- Press \texttt{on} to display the Home screen, and then point to the application you would like to add to the new page and click or tap.

A new page is added to the current problem.
Moving Through Pages in a Document

Tabs display up to three multiple pages. When a document contains more than three pages, arrows appear on the left and right of the tabs.

Use the following keys to navigate through your documents.

- \(\text{ctrl} \downarrow\) displays the previous page.
- \(\text{ctrl} \uparrow\) displays the next page.
- \(\text{ctrl} \uparrow\) displays the Page Sorter.
- \(\text{ctrl} \downarrow\) displays the previous view.
- Use the Touchpad to click on the arrows that appear on either side of the tabs to show additional pages in a document containing more than three pages.

Managing Documents

My Documents is a file manager in which you store and organize your documents. The example below illustrates the My Documents screen with its main parts labeled. Following the screen, you can find descriptions of each labeled part.
Browsing Files in My Documents

To open My Documents:

- Press [on 2].

**Note:** If you are working in a page, press [ctrl ▲ ctrl ▲].

The My Documents screen opens, displaying all folders and files on the handheld.

- To sort columns by name or size, click that column head. Click again to change the sort from ascending to descending.
- To scroll through My Documents, click or grab the scroll bar.
- To expand a single folder, point to the folder and click on the folder icon or press [ctrl ▲]. To collapse, click again or press [ctrl ▼].
- To expand all folders, press [menu 7]. To collapse, press [menu 8].

Renaming Folders or Documents

To rename a folder or document:

1. Press the ▲ and ▼ keys to highlight the document or folder you want to rename.
2. Press [menu 2].
3. Type a new name and press \text{enter} to complete the change.

\textbf{Note:} Press \text{esc} to cancel.

\textbf{Creating Folders}

You can create folders two different ways:

- You can create a folder when you save a new document: The \textit{Save} and \textit{Save As} menu commands allow you to enter a new folder name for the document.

- You can create a folder directly from the My Documents screen. Press \text{menu} 1. Type a name for new folder, and press \text{esc} or \text{enter} to add it.

\textbf{File and Folder Naming Conventions}

Folder names must be unique. File and folder names can be very long, and can include almost all characters, including spaces and punctuation.

\textbf{Note:} If you are planning to transfer these documents to your computer for use in the TI-Nspire™ software, it is best to use names that are accepted on your computer. Avoid punctuation, \textbackslash, \text/, or symbols.

\textbf{Deleting Documents and Folders}

1. Press \text{dir} and \text{dir} to highlight the document or folder you want to delete.

2. Press \text{ctrl} \text{menu} 6.

---or---

Press \text{del}.
A dialog box opens, confirming that you want to delete the file or folder.

3. Press ✎ or enter to select Yes.

The document is deleted.

**Duplicating Documents and Folders**

Use Copy Ctrl C and Paste Ctrl V to duplicate documents and folders.

To copy a document to another folder, select the desired folder, and then paste.

**Recovering Deleted Documents**

Most operations performed in My Documents can be undone. Press Ctrl Z (Undo) to cancel the last operation until the deleted document is restored.

**Closing a Document**

1. To close a document, press doc • 1 3.

—or—

Press Ctrl W.
If you have changed the document, you will be asked whether you want to save those changes.

2. Click **Yes** to save the document or click **No** to abandon the changes.

### Understanding the TI-Nspire™ Tools

This section provides an overview of the tools used when working with TI-Nspire™ documents on a handheld, including variables, catalog, symbols, and math templates.

#### Creating TI-Nspire™ Variables

Variables can be any portion or attribute of an object or function created within an application. Examples of attributes that can become variables are the area of a rectangle, the radius of a circle, the value contained in a spreadsheet cell or the contents of a column, or a function expression. When you create a variable, it is stored in memory within the problem. You will find more information about variables in the chapter titled *Using Variables*.

#### Using the Catalog

Use the catalog to access a list of TI-Nspire™ commands and functions, units, symbols and expression templates. Commands and functions are listed alphabetically. Commands or functions not beginning with a letter are found at the end of the list (&, /, +, -, and so on). To open the catalog:

1. From an open document, press `Cat` to open the catalog.

2. Press the number key corresponding to the appropriate tab.

   For example, press **2** to show a list of math functions.

3. Press **▼** until the item you want to insert is highlighted.

   A syntax example for the selected item is displayed at the bottom of the screen.
**Note:** To see additional syntax examples of the selected item, press `tab`, and then press `enter` to maximize or minimize the Help. To move back to the selected item, press `shift` `tab`.

4. Press `enter` to insert the item.

**About the Catalog Window**

The catalog window uses these tabs to categorize commands, special characters, and templates in documents:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Contains all commands and functions, in alphabetical order</td>
</tr>
<tr>
<td>2</td>
<td>Contains all math functions</td>
</tr>
<tr>
<td>3</td>
<td>Provides the values for standard measurement units</td>
</tr>
<tr>
<td>4</td>
<td>Provides a symbol palette for adding special characters</td>
</tr>
<tr>
<td>5</td>
<td>Contains math templates for creating two dimensional objects, including product, sum, square root, and integral</td>
</tr>
<tr>
<td>6</td>
<td>Shows public library (LibPub) objects.</td>
</tr>
</tbody>
</table>

**Using Wizards**

Some catalog functions have a wizard to help you enter function arguments. To use a wizard, press `tab` until the **Wizards On** box is highlighted. Press `tab` or `enter` to select the check box.

**Entering Special Characters**

The symbol palette contains a subset of the objects found in the catalog. To open the symbol palette:

1. In an open document, press `ctrl` `alt`. |
2. Press \( \downarrow, \uparrow, \leftarrow, \text{or} \rightarrow \) to select a symbol.

3. Press \( \text{enter} \) to insert the symbol.

**Entering Math Expressions**

Use math expression templates to create two-dimensional objects such as summation, integral, derivative, and square root. To open the math expressions palette:

1. In an open document, press \( \text{[M]} \).

2. Press \( \downarrow, \uparrow, \leftarrow, \text{or} \rightarrow \) to select an expression.

3. Press \( \text{[C]} \) or \( \text{enter} \) to insert the expression.

**Entering International Language Characters**

Use the \( \text{[Ç]} \) key to enter specially accented or punctuated characters in applications such as Notes that allow text input.

1. Open an application such as Notes that allows text input.
2. Type the desired text.
3. Position the cursor after the letter that you want to accent. For example, “e” while in the French locale.

4. Press \( \text{F2} \) on the keypad. Notice that the “e” changes to “é.” Keep pressing \( \text{F2} \) until you find the accented version of e that you want. Press \( \text{F2} \) or the next letter of your text to accept the character and continue typing.
Working with Images

Images can be used in TI-Nspire™ applications for reference, assessment, and instructional purposes. You can add images to the following TI-Nspire™ applications:

- Graphs & Geometry
- Data & Statistics
- Notes
- Question, including Quick Poll

In the Graphs & Geometry and Data & Statistics applications, images are set in the background behind the axis and other objects. In the Notes and Question applications, the image is set at the cursor location inline with the text (in the foreground).

You can insert the following image file types: .jpg, .png, or .bmp.

Note: The transparency feature of a .png file type is not supported. Transparent backgrounds are displayed as white.

Working with Images on a Handheld

On a handheld, images can be copied from one document to another or resized or repositioned within a document. You can also delete images from a document.

You cannot add or insert images into a document when working on a handheld. However, you can transfer a document containing an image from your computer to a handheld.

Note: If there is not enough storage on the handheld to accommodate a document containing an image, an error message is displayed.

Copying an Image

Complete the following steps to copy an image from one document to another or from one page to another within the same document.

1. Open the document that contains the image you want to copy.
2. Select the image.
   - In the Question or Notes applications, move the cursor over the image and press \[^2\].
   - In the Graphs & Geometry application, press \[\text{menu} \ 1 \ 2 \ 2\].
   - In the Data & Statistics application, press \[\text{menu} \ 3 \ 6\].

A border appears around the image.

3. Press \[\text{ctrl} \ \text{menu}\], and then click Copy. You can also press \[\text{ctrl} \ C\].
4. Open the document where you want to paste the image or select a page in the current document.
Note: If you open a new document, you will be prompted to save and close the current document.

5. Press \text{ctrl V}.

Note: If pasting an image into the Graphs & Geometry application, press \text{enter}, and then press \text{ctrl V}.

The image is copied to the page in the document.

**Repositioning an Image**

Complete the following steps to reposition an image on a page.

1. Open the document and navigate to the page that contains the image.
2. Select the image.
   - In the Question or Notes applications, move the cursor over the image, and then press \text{hold} and release \text{select}. The image appears shaded.
   - In the Graphs & Geometry application, press \text{select 1 2 2}.
   - In the Data & Statistics application, press \text{select 3 6}.

A border appears around the image.

3. Move the image.
   - In the Question or Notes applications, move the cursor to the new location and press \text{select}.
   - In the Graphs & Geometry or Data & Statistics applications:
     - Press and hold \text{select} until the cursor changes to a four-sided arrow ( 
     ). The image floats in the background and the border changes to a dashed line.
     - Move your finger over the Touchpad to move the image to the new location, and then press \text{select} or \text{select} to place the image.

**Resizing an Image**

Complete the following steps to resize an image on a page.

1. Open the document that contains the image.
2. Select the image.
   - In the Question or Notes applications, or in Quick Poll, move the cursor over the image and press, hold, and then release \text{select}. The image appears shaded.
   - In the Graphs & Geometry application, press \text{select 1 2 2}.
   - In the Data & Statistics application, press \text{select 3 6}.

A border appears around the image.

3. Move the cursor to one of the corners.
The cursor changes to a four-sided directional arrow ( ).

**Note:** If you move the cursor to the edge of an image, the cursor changes to a two-sided directional arrow. You can drag the image left or right to resize it, but the image will become distorted.

4. Press .

The tool is enabled.

5. Move your finger over the Touchpad in any direction to resize the image.

A dashed line appears to indicate the new size.

6. To accept the new size, press or enter.

**Deleting an Image**

Complete the following steps to remove an image from a page.

1. Open the document that contains the image.

2. Select the image.
   - In the Question or Notes applications, move the cursor over the image, and then press, hold, and release . The image appears shaded.
   - In the Graphs & Geometry application, press .
   - In the Data & Statistics application, press .

A border appears around the image.

3. Press , and then select Delete.

The image is removed.

**Note:** In the Question and Notes applications, you can also press to remove a selected image.
Working in a TI-Nspire™ CX Premium Teacher Software Classroom

If you are in a classroom where TI-Nspire™ CX Premium Teacher Software is used, you will need to log in to class to communicate with the teacher’s computer. The teacher can communicate with your handheld in the following ways:

- Send files
- Collect files
- Delete files
- Send Quick Polls and receive Quick Poll responses

The teacher can also pause and restart your handheld. When class is paused, you will receive a message on your handheld. You cannot use your handheld until the teacher releases the handheld from pause mode.

**Using Wireless Communication Hardware**

Teachers using TI-Nspire™ CX Premium Teacher Software in the classroom can attach wireless cradles and/or network adapters to students' TI-Nspire™ CX handhelds. Those handhelds can then link wirelessly to an access point attached to the teacher's computer.

You can attach any of the following devices to TI-Nspire™ CX handhelds:

- TI-Nspire™ CX Wireless Network Adapter - v2 (2.4 GHz or 5.0 GHz band)
- TI-Nspire™ Wireless Network Adapter (2.4 GHz)

**Attaching a Wireless Adapter to a CX Handheld**

**Note:** The battery in the handheld powers the wireless adapter.

1. Position the wireless adapter on top of the handheld so the connector on the adapter lines up with the connector on top of the handheld.

![Connector](image)

2. Slide the adapter into position, making sure the guides on the sides of the adapter slide into the grooves on the sides of the handheld.
3. Firmly press the adapter into place so that the adapter sits on top of the handheld as shown in the following illustration.

**Note:** The TI-Nspire™ CX handheld can be charged with the wireless adapter attached.

### Connecting to the TI-Nspire™ CX Navigator™ System

To connect to the TI-Nspire™ CX Navigator™ network, you must log in to the network from your handheld. Before you can log in, the teacher must complete the following tasks:

- Start a class session on their computer.
- Provide you with the class network name, a username and, if necessary, a password.

### Logging in to the Network

1. Attach a wireless adapter or wireless cradle to the handheld.
2. Ensure your TI-Nspire™ CX II handheld is ready for login. (The icon is blinking.)

3. Complete one of the following actions:
   - From the Home screen, press 5 5.
   - From an open document, press doc 8.

   The Login to Class dialog box opens and the last network that was associated with the wireless client appears.

   ![Login to Class dialog box](image)

   **Note:** If the handheld is connected to the computer with the USB cable, no network names appear on the screen, and you can continue logging in.

4. If the name of the network that appears is correct, click Login. If the network is not correct, click Network.

   The handheld screens displays the last network the wireless client was attached to, and also displays other networks within range.

   ![TI-Nspire Networks](image)

5. Select the network from the list, and then click Connect.
The login screen shows the connection status and displays the network name when the connection is successful.

6. Type your username and password.
7. Select Login.

The Login Successful screen opens.

8. Click OK.

**TI-Nspire™ Handheld Login Status Icons**

The icons on the TI-Nspire™ CX II and TI-Nspire™ CX II CAS handheld screens indicate the communication status between the handheld and the access point, wireless adapter, wireless cradle, or TI-Navigator™ network. The icons indicate status as follows.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Status</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Blinking Icon" /></td>
<td>Blinking</td>
<td>The handheld is searching for an access point.</td>
</tr>
<tr>
<td><img src="image" alt="Solid Icon" /></td>
<td>Solid</td>
<td>The handheld has found an access point.</td>
</tr>
<tr>
<td><img src="image" alt="Solid Icon" /></td>
<td>Solid</td>
<td>The handheld is not communicating with the adapter or cradle. Remove the handheld from the adapter or cradle, wait for the icon to disappear, and then reattach the handheld to the adapter or cradle.</td>
</tr>
<tr>
<td><img src="image" alt="Blinking Icon" /></td>
<td>Blinking</td>
<td>The handheld is connected to the network and is ready to login.</td>
</tr>
<tr>
<td><img src="image" alt="Solid Icon" /></td>
<td>Solid</td>
<td>The handheld is logged in to the network.</td>
</tr>
</tbody>
</table>

**Understanding File Transfers**

During a class session, the teacher can send files to student handhelds and collect or delete files from student handhelds.

**Note:** Before class starts, teachers can set up actions to send or collect files. When you log in, the files are sent or collected. If the teacher set up actions to both send and collect files, you will only see the dialog box for the last action completed.
Opening Sent Files

When the teacher sends a file to your handheld, the Transfers Complete dialog box opens.

- Click **Open** to open the file. If the teacher sent multiple files, this opens the last file in the list.

  **Note:** The files are received alphabetically by name, no matter which order the teacher sent them in. The last file in the list is the last alphabetical file.

- Click **Go To** to go to the location on the handheld where the file was sent. The file name is highlighted. You can open that file, or navigate to another file. If the teacher sent multiple files, the last alphabetical file in the list is highlighted.

- Click **OK** to dismiss the dialog box without opening the file. Your handheld returns to the state it was in when the message was sent.

Collecting or Deleting Files

Your teacher may collect or delete files from your handheld during a class session. For example, teachers can collect homework assignments or delete certain files prior to a test. When the teacher collects or deletes files, you receive a message on your handheld.
Click **OK** to dismiss the message.
Configuring Handhelds

This chapter provides information needed to:

- Maintain batteries used in the handheld.
- Change the default settings.
- Attach a wireless module when the handheld is used in the classroom.

**Checking Battery Status**

To check the status of the TI-Nspire™ Rechargeable Battery in a handheld:

1. Press \(\text{on}\).
   The Home screen opens.
2. Press \(5 4\) (Settings > Status).
   The Handheld Status dialog box opens.

   **Handheld Status**
   
   - Batteries: 100%
   - Version: 5.0.0.1297
   - Storage Capacity: 92.3 MB
   - Storage Available: 91.8 MB
   - Network: Wireless client is not attached.
   - Login: Not logged in.

   Battery status is shown here.

3. Click OK or press \(\text{enter}\) to close the window.

   **Note:** From an open document, press \(\text{doc} \ 7 \ 4\) (doc > Settings & Status > Status).

**Recharging the Handheld**

To recharge the TI-Nspire™ Rechargeable Battery in a handheld, connect it to any of the following power sources:

- A standard USB cable connected to a computer
- A TI USB wall charger (sold separately)
- A TI-Nspire™ CX Docking Station if in a classroom setting
The amount of time required to fully charge the battery may vary, but charging normally takes about six hours. It is not necessary to remove the TI-Nspire™ Rechargeable Battery from the handheld to recharge it. The handheld operates normally while it is attached to a charging source.

**Recharging a Battery from a Computer**

To recharge a handheld from a computer, a TI-Nspire™ USB driver must be installed. USB drivers are standard with any TI-Nspire™ software, which includes:

- TI-Nspire™ CX Premium Teacher Software
- TI-Nspire™ CX CAS Premium Teacher Software
- TI-Nspire™ CX Student Software
- TI-Nspire™ CX CAS Student Software

To download software that includes a driver, go to education.ti.com/software.

**Understanding the Priority of Power Sources**

When the TI-Nspire™ Rechargeable Battery is fully charged, the handheld draws power in the following order:

- First, from a connected external power source, such as:
  - A computer connected through a standard USB cable
  - An approved wall charger (sold separately)
- Second, from the TI-Nspire™ Rechargeable Battery

**Disposing of Used Batteries Safely and Properly**

Do not mutilate, puncture or dispose of batteries in fire. The batteries can burst or explode, releasing hazardous chemicals. Discard used batteries according to local regulations.

**Changing Handheld Settings**

Use the options on the Settings menu to change or view the following settings:

- Change language
- Settings (Document and Graphs & Geometry)
  - Define or restore settings for open documents and the Scratchpad
  - Define or restore default settings for the handheld
- Handheld Setup
- Status
- Login

**Note:** Not all options are accessible at all times. Options that are unavailable are disabled.
Opening the Settings Menu

- From the Home screen, press 5 or use the Touchpad to select Settings.

The Settings menu opens.

| 1 Change Language... |
| 2 Document Settings... |
| 3 Handheld Setup... |
| 4 Status... |
| 5 Login... |
| 6 Network... |
| 7 TI-Innovator Hub... |
| 8 Restore Factory Defaults... |

Changing a Preferred Language

Complete the following steps to change a preferred language:

1. From the Home screen, press 5 or select Settings to open the menu.
2. From the menu, select Change Language or press 1.

The Change Language dialog box opens.

3. Press ▶ to open the drop-down list.
4. Press ▼ to highlight a language, then press ▶ or enter to select it.
5. Press tab to highlight the OK button, and then press ▶ or enter to save the language selection.

Customizing the Handheld Setup

Handheld setup options enable you to customize options to suit your needs.

- Font size (small, medium or large).
- Power standby. (1, 3, 5, 10 or 30 minutes).
  - Use this option to extend battery life.
  - By default, the handheld automatically powers down after three minutes of inactivity.
- Hibernate (1, 2, 3, 4, 5 days or never).
  - Use this option to extend battery life.
  - When hibernating, the handheld saves current work in memory.
- When you turn the handheld on again, the system reboots and opens saved work.

- Pointer speed (slow, normal or fast).
- Auto dim (30, 60 or 90 seconds, and two or five minutes).
- Enable tapping to click.

### Changing Handheld Setup Options

1. From the Home screen, press 53 (Settings > Handheld Setup).

   The Handheld Setup dialog box opens.

   ![Handheld Setup dialog box](image)

2. Press tab until the desired category is highlighted.

3. Press ▲ to view the list of possible settings.

4. Press ▼ to highlight the desired setting.

5. Press 2 or enter to select the new setting.

6. When you have changed all the settings to suit your needs, press tab until OK is highlighted, then press 2 or enter to apply your changes.

### Customizing Document Settings

Document settings control how the handheld displays and interprets information in TI-Nspire™ documents and in Scratchpad. All numbers, including elements of matrices and lists, are displayed according to the document settings. You can change the default settings at anytime and you can also specify settings for a particular document.

Document settings and their possible values are listed in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display Digits</td>
<td>• Float</td>
</tr>
<tr>
<td></td>
<td>• Float1 - Float12</td>
</tr>
<tr>
<td></td>
<td>• Fix0 - Fix12</td>
</tr>
<tr>
<td>Angle</td>
<td>• Radian</td>
</tr>
<tr>
<td></td>
<td>• Degree</td>
</tr>
<tr>
<td>Field</td>
<td>Values</td>
</tr>
<tr>
<td>----------------------------</td>
<td>------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Exponential Format</td>
<td>- Normal</td>
</tr>
<tr>
<td></td>
<td>- Scientific</td>
</tr>
<tr>
<td></td>
<td>- Engineering</td>
</tr>
<tr>
<td>Real or Complex</td>
<td>- Real</td>
</tr>
<tr>
<td></td>
<td>- Rectangular</td>
</tr>
<tr>
<td></td>
<td>- Polar</td>
</tr>
<tr>
<td>Calculation Mode</td>
<td>- Auto</td>
</tr>
<tr>
<td></td>
<td>- Exact</td>
</tr>
<tr>
<td></td>
<td>- Approximate</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>Auto mode shows an answer that is not a whole number as a fraction except when a decimal is used in the problem. Exact mode (CAS only) shows an answer that is not a whole number as a fraction or in symbolic form, except when a decimal is used in the problem.</td>
</tr>
<tr>
<td>Exact Arithmetic</td>
<td>- On</td>
</tr>
<tr>
<td></td>
<td>- Off</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>This option is only available on Exact Arithmetic handhelds.</td>
</tr>
<tr>
<td>CAS Mode</td>
<td>- On</td>
</tr>
<tr>
<td></td>
<td>- Exact Arithmetic</td>
</tr>
<tr>
<td></td>
<td>- Off</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>This option is only available on CAS handhelds and software.</td>
</tr>
<tr>
<td>Vector Format</td>
<td>- Rectangular</td>
</tr>
<tr>
<td></td>
<td>- Cylindrical</td>
</tr>
<tr>
<td></td>
<td>- Spherical</td>
</tr>
<tr>
<td>Base</td>
<td>- Decimal</td>
</tr>
<tr>
<td></td>
<td>- Hex</td>
</tr>
<tr>
<td></td>
<td>- Binary</td>
</tr>
<tr>
<td>Unit System</td>
<td>- SI</td>
</tr>
<tr>
<td></td>
<td>- Eng/US</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>This option is only available on CAS handhelds and software.</td>
</tr>
</tbody>
</table>

**Changing Default Document Settings**

Complete the following steps to define default document settings for TI-Nspire™ documents and Scratchpad.
1. Save and close any open documents.

2. From the Home screen, press 5 2 (Settings > Document Settings).

The Document Settings dialog box opens.

3. Press → to move through the list of settings. Press ↑ to move backward through the list.

   A bold line around a box indicates it is active.

4. Press ▲ to open the drop-down list to view the values for each setting.

5. Press the ▲ and ▼ keys to highlight the desired option, then press  or  to select the value.

6. Click OK to save the settings as default settings that will be applied to all new TI-Nspire™ documents and to Scratchpad.

**Changing Document Settings in a TI-Nspire™ Document**

Complete the following steps to change document settings for an open TI-Nspire™ document. The settings will also be applied to Scratchpad and used as the default for all new documents.

1. From an open document, press 5 2 (Settings > Document Settings).

   The Document Settings dialog box opens.
2. Press \text{tab} to move through the list of settings. Press \text{^} to move backward through the list.

A bold line around a box indicates it is active.

3. When you reach the desired setting, press \text{▼} to open the drop-down list to view values for each setting.

4. Press the \text{▲} and \text{▼} keys to highlight the desired option, then press \text{#} or \text{enter} to select the value.

5. Click \text{OK} or press \text{#} or \text{enter} to apply the new settings to the open document, and to set as the default for new documents and Scratchpad.

Restoring Document Settings

Complete the following steps to restore the original factory settings to open or new documents, and to the Scratchpad.

1. From the Home screen, press \text{5 8} (Settings > Restore Factory Defaults).

   The Restore Defaults dialog box opens.

2. Click \text{OK} to restore settings to the factory default settings.

3. Press \text{ESC} or click \text{Cancel} to return to the Home screen without making changes.
Customizing Graphs & Geometry Settings

Graphs & Geometry settings control how information is displayed in open problems and in subsequent new problems. When you customize application settings, your selections become the default settings for all of your work in the Graphs and Geometry applications.

Complete the following steps to change the Graphs & Geometry Settings and make these settings the default for all new graphs and geometry documents and Scratchpad.

1. Open a document with the Graphs or Geometry application active.
2. Press \(\text{menu} \ 9\) (\text{menu} > Settings).

The Graphs & Geometry Settings dialog box opens.

3. Press \(\text{tab}\) to move through the list of settings. Click \(\uparrow\) to open the drop-down list to view the values for each setting.

<table>
<thead>
<tr>
<th>Field</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display Digits</td>
<td>Auto</td>
</tr>
<tr>
<td></td>
<td>Float</td>
</tr>
<tr>
<td></td>
<td>Float1 - Float12</td>
</tr>
<tr>
<td></td>
<td>Fix0 - Fix12</td>
</tr>
<tr>
<td>Graphing Angle</td>
<td>Auto</td>
</tr>
<tr>
<td></td>
<td>Radian</td>
</tr>
<tr>
<td></td>
<td>Degree</td>
</tr>
<tr>
<td></td>
<td>Gradian</td>
</tr>
<tr>
<td>Geometry Angle</td>
<td>Auto</td>
</tr>
<tr>
<td></td>
<td>Radian</td>
</tr>
<tr>
<td></td>
<td>Degree</td>
</tr>
<tr>
<td></td>
<td>Gradian</td>
</tr>
<tr>
<td>Grid</td>
<td>No Grid</td>
</tr>
</tbody>
</table>
4. Press \( \downarrow \) to view the values, then press \( \mathbb{R} \) or \( \text{enter} \) to select a value.

5. In the lower half of the dialog, select a checkbox to enable an option or clear a checkbox to disable an option.

<table>
<thead>
<tr>
<th>Checkbox</th>
<th>Operation when selected</th>
</tr>
</thead>
<tbody>
<tr>
<td>Automatically hide plot labels</td>
<td>Plot labels display only when a plot is hovered, selected or grabbed.</td>
</tr>
<tr>
<td>Show axis end values</td>
<td>Displays a numeric label at the least and greatest values visible on an axis.</td>
</tr>
<tr>
<td>Show tool tips for function manipulation</td>
<td>Shows helpful information as you manipulate function graphs.</td>
</tr>
<tr>
<td>Automatically find points of interest</td>
<td>Shows zeros, minima and maxima for graphed functions and objects while tracing function graphs.</td>
</tr>
<tr>
<td>Force geometric triangle angles to integers</td>
<td>Restricts the angles of a triangle to integer values as you create or edit the triangle. This setting applies only in the Geometry View with the Geometry Angle unit set to Degree or Gradian. It does not apply to analytic triangles in Graphing View or to analytic triangles in the Analytic Window of the Geometry View. This setting does not affect existing angles, and it does not apply when constructing a triangle based on previously inserted points. By default, this setting is deselected.</td>
</tr>
<tr>
<td>label points</td>
<td>Applies labels ( A, B, ..., Z, A_1, B_1, ) and so on) to points, lines, and vertices of geometric shapes as you draw them. The labeling sequence starts at ( A ) for each page in a document. By default, this setting is deselected. <strong>Note:</strong> If you create a new object that uses existing unlabeled points, those point are not automatically labeled in the completed object.</td>
</tr>
</tbody>
</table>

6. Choose one of the following options:
   - To apply the settings to the open document only, click **OK**.
   - Click **Cancel** to close the dialog box without making changes.
**Viewing Handheld Status**

The Handheld Status screen provides the following information about the current state of the handheld:

- Battery status for the rechargeable batteries
- Software version
- Storage capacity and amount of storage available
- Network (if any)
- Your student login name and whether you are logged in

**Opening the Handheld Status Screen**

1. From the Home screen, press **5 4 (Settings > Status)**.

   The Handheld Status screen opens.

   ![Handheld Status Screen](image)

   - Batteries: 100%
   - Version: 5.0.0.1297
   - Storage Capacity: 92.3 MB
   - Storage Available: 91.8 MB
   - Network: Wireless client is not attached.
   - Login: Not logged in.

   - Click **OK** to close the Handheld Status screen.

**Viewing Handheld Details**

The About screen provides additional information about the handheld type, the operating system (OS) version, and the product ID.

1. From the Home screen, press **5 4 (Settings > Status)**.

   The **Handheld Status** screen opens.

2. Click **About** to view details about the handheld.
3. Click OK to close the About dialog box.
4. Click OK to return to the Home screen.

**Replacing TI-Nspire™ Rechargeable Batteries**

When you replace the battery, complete the following steps to insert the TI-Nspire™ Rechargeable Battery into a handheld.

**Note:** Your handheld may not exactly match these illustrations.

1. Use a small screwdriver to release the panel from the back of the handheld.

![Image](insert_image1.png)

2. Remove the panel.

![Image](insert_image2.png)

3. Remove the old battery.
4. Insert the rechargeable battery into its compartment.

![Image](insert_image3.png)

5. Replace the back panel and fasten it with a screwdriver.
**Precautions for Rechargeable Batteries**

- Do not expose batteries to temperatures above 140°F (60°C).
- Do not disassemble or mistreat batteries.
- Use only the charger recommended for the cell or battery, or the one that was provided with the original equipment.
- TI recommends that you use the USB cable included with this calculator. If you choose to use a third-party power adapter with the TI-supplied USB cable, you should use an adapter that meets applicable safety and operational standards and certifications, including UL and CE certifications.

Take these precautions when replacing rechargeable batteries:

- Replace only with a TI approved battery.
- Remove the cell or battery from the charger or alternating current adapter when not in use or being charged.
- Use of the battery in other devices may result in personal injury or damage to equipment or property.
- Do not mix brands (or types within brands) of batteries. There is a risk of explosion if a battery is replaced by the wrong type.

**Disposing of Batteries**

Do not mutilate, puncture, or dispose of batteries in fire. The batteries can burst or explode, releasing hazardous chemicals. Discard used batteries according to local regulations.
Connecting Handhelds and Transferring Files

This chapter describes how to connect one TI-Nspire™ CX II handheld to another, how to connect handhelds to a computer, and how to transfer files between them.

The TI-Nspire™ handhelds have a USB port that enables connectivity with another TI-Nspire™ handheld or with a computer.

For web-based connectivity using your TI-Nspire™ CX II with a Chromebook, Windows® computer, or Mac® computer, go to TI-Nspire™ CX II Connect.

**Connecting Handhelds**

You can use USB cables to connect two TI-Nspire™ handhelds or to connect a TI-Nspire™ handheld to a computer.

1. Firmly insert either end of the mini-USB cable into the USB port.

**Connecting Two TI-Nspire™ Handhelds with the Mini-USB Cable**

The USB port is located on the top of the TI-Nspire™ CX II handheld on the right side when holding the handheld with the screen facing you.
2. Insert the other end of the cable into the receiving handhelds’ USB port.

Connecting the TI-Nspire™ Handheld to a Computer
1. Firmly insert the mini-USB end of the cable into the port at the top of your handheld.
2. Firmly insert the USB end of the cable into the USB port of the computer.

Transferring Files between Handhelds
You can send documents, Operating System (OS) files, and folders to another TI-Nspire™ handheld.

Note: TI-Nspire™ CX handhelds must be running v4.5.1 or later of the OS in order to transfer to or from TI-Nspire™ CX II handhelds.

Rules for Transferring Files and Folders
- You can transfer documents and OS files.
- Operating systems are not interchangeable between different handheld types. For example, you cannot transfer a CAS operating system to a non-CAS handheld.
- If a document with the same name as the one you are sending already exists on the receiving handheld, the document will be renamed. The system appends a number to the name to make it unique. For example, if Mydata existed on the receiving handheld, it would be renamed Mydata(2).

Both the sending and receiving handhelds will display a message that shows the new name.

- There is a 255-character maximum length for a file name, including the entire path. If a transmitted file has the same name as an existing file on the receiving handheld and the file names contain 255 characters, the name of the transmitted file will be truncated to enable the software to follow the renaming scheme described in the previous paragraph.
- All variables associated with the document being transmitted are transferred with the document.
- Transmissions will time out after 30 seconds.

Caution: Some older TI-Nspire™ handhelds cannot receive folders; only files. If you receive an error in sending to an older TI-Nspire™ handheld, see Common error and notification messages.

Sending a Document or Folder to Another Handheld
1. Ensure the two handhelds are connected.
2. Open the My Documents file browser and navigate to the file or folder you want to transfer.
3. Press the ▲ and ▼ keys on the Touchpad to highlight the document or folder you want to send.
4. Press doc 1 6 to select Send from the Documents menu.
5. The file transfer begins. A progress bar shows the status of the transfer. There is also a cancel button in the Sending... dialog box to enable you to cancel the transmission while it is in progress.

At the end of a successful transmission, the message “<Folder / File name> transferred as <Folder / File name>.” is displayed. If the file had to be renamed on the receiving handheld, the message will show the new file name.

Receiving a Document or Folder

No action is required by the user of the receiving TI-Nspire™ handheld. Handhelds are automatically powered on when the cable is attached.

At the end of a successful transmission, the message “<Folder / File name> received.” is displayed. If the file had to be renamed, the message will show the new file name.

Caution: Some older TI-Nspire™ handhelds cannot receive folders; only files. If you receive an error in sending to an older TI-Nspire™ handheld, see Common error and notification messages.

Canceling a Transfer

1. To cancel a transmission in progress, press Cancel on the sending handheld. The user of either handheld can also press esc .

2. Press esc or enter to cancel the transmission error message.

Transferring Files between Computers and Handhelds

In the Documents Workspace, teachers and students can use the “drag and drop” method to quickly transfer files and folders from a computer to a handheld or transfer files from a handheld to a computer.

Note: You must be running v5.0 or later of the TI-Nspire™ software in order to transfer to or from TI-Nspire™ CX II handhelds.

1. Connect the handheld to the computer using a standard A to mini-B USB cable.

2. In the TI-Nspire™ software, open the Documents Workspace.

3. In the Documents Toolbox, click to open the Content Explorer.
4. Navigate to the folder that contains the file you want to transfer.
   - To transfer a file from a handheld to the computer, click the file, and then drag the file to a folder in the Computer panel.
   - To transfer a file from the computer to a handheld, click the file, and then drag the file to a connected handheld.

**Note:** Those using the TI-Nspire™ CX Premium Teacher Software or the TI-Nspire™ CX Navigator™ Teacher Software can also use options in the Content Workspace to transfer files from a handheld to a computer.
Using the Save to Handheld Option

In the Documents Workspace, you can also use the Save to Handheld option on the File menu to transfer a file to a connected handheld when you want to save a file to a specific folder on the handheld.

1. Ensure the handheld is connected to the computer.
2. In the Computer panel, navigate to the folder where the file is located.
3. Click the file.
4. Click File > Save to Handheld. The Save to Handheld dialog box opens.

![Save to Handheld dialog box]

5. Double-click the handheld name, and then navigate to the folder where you want to save the file.
6. Click Save. The file is saved to the selected folder and the Save to Handheld dialog box closes.

Handling Errors Resulting from Sending Folders

If you receive an error after attempting to send a file, it may mean the receiving handheld has an operating system that does not support the transfer. To resolve this, update the receiving handheld’s OS and try the send again.

Common Error and Notification Messages

<table>
<thead>
<tr>
<th>Shown on Sending handheld</th>
<th>Message and Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>“This folder structure is not supported on the receiving handheld. The receiving handheld’s OS may need to be updated, which you can do by selecting Send OS from the My Documents menu.”</td>
</tr>
<tr>
<td></td>
<td>OK</td>
</tr>
</tbody>
</table>

If you get an error when sending a folder to an older TI-Nspire™ handheld, try updating the OS on the receiving handheld. If the error persists, you may have to send the files individually.
<table>
<thead>
<tr>
<th>Shown on Sending handheld</th>
<th>Message and Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>“Transfer failed. Check cable and try again.&quot; OK</td>
</tr>
<tr>
<td></td>
<td>This message is displayed if a cable is not attached to the sending handheld’s link port. Remove and then reinsert the cable and try the document transmission again. Click OK to cancel the transmission message. <strong>Note:</strong> The sending handheld may not always display this message. Instead, it may remain BUSY until you cancel the transmission.</td>
</tr>
<tr>
<td>Sending handheld</td>
<td>“Receiver does not have enough storage space for file transfer.&quot; OK</td>
</tr>
<tr>
<td></td>
<td>This message indicates that the receiving handheld does not have enough storage to accept the file being transmitted. The user of the receiving handheld must free space to obtain the new file. To do this:</td>
</tr>
<tr>
<td></td>
<td>• Delete unneeded files.</td>
</tr>
<tr>
<td></td>
<td>• Store files on a computer for later retrieval, and then delete them from the TI-Nspire™ handheld.</td>
</tr>
<tr>
<td>Sending handheld</td>
<td>“&lt;folder&gt;/&lt;filename&gt; transferred as &lt;folder&gt;/&lt;filename(#)).&quot;</td>
</tr>
<tr>
<td></td>
<td>This message is displayed at the end of a successful transfer when the file had to be renamed because a file already exists on the receiving handheld with the original name. The transmitted file is renamed by appending a number to the end of the name. Rename numbering always begins with (2) and can increment by one, as needed.</td>
</tr>
<tr>
<td>Sending handheld</td>
<td>“&lt;folder&gt;/&lt;filename&gt; transferred as &lt;folder&gt;/&lt;new filename&gt;.&quot;</td>
</tr>
<tr>
<td></td>
<td>This message indicates that a new folder was created on the receiving handheld to contain the transmitted document.</td>
</tr>
<tr>
<td>Receiving handheld</td>
<td>“&lt;folder&gt;/&lt;filename(x)&gt; received.&quot;</td>
</tr>
<tr>
<td></td>
<td>This message indicates that the receiving handheld has a document with the same name as the document being sent.</td>
</tr>
<tr>
<td>Receiving handheld</td>
<td>“&lt;new folder&gt;/&lt;new filename&gt; received.&quot;</td>
</tr>
<tr>
<td></td>
<td>This message indicates that a new folder has been created to contain the transmitted document.</td>
</tr>
<tr>
<td>Receiving handheld</td>
<td>“Transfer failed. Check cable and try again.&quot; OK</td>
</tr>
<tr>
<td></td>
<td>This message indicates that the cable is not correctly attached to the receiving handheld’s link port. Remove the cable then reattach it and try the transmission again.</td>
</tr>
<tr>
<td>Shown on</td>
<td>Message and Description</td>
</tr>
<tr>
<td>----------</td>
<td>-------------------------</td>
</tr>
<tr>
<td></td>
<td>Click <strong>OK</strong> to cancel the transmission message.</td>
</tr>
</tbody>
</table>
File Management

The TI-Nspire™ CX II Handheld comes equipped with 128 MB of Flash storage. The operating system uses part of that storage, and saving new documents on the handheld further reduces the amount of available storage over time. To avoid or resolve storage space issues, use one of the following options:

- Delete documents and folders you no longer use.
- Back up files and folders to another handheld or computer.
- Reset the storage, which deletes ALL files and folders on the handheld.

Checking Available Storage

Complete the following steps to view the amount of storage (in bytes) that is available on your handheld.

1. From the Home screen, select Status from the Settings menu.

Press \[\text{on} \times 5 \times 4\].

The Handheld Status window opens.

<table>
<thead>
<tr>
<th>Handheld Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>Batteries: 100%</td>
</tr>
<tr>
<td>Version: 5.0.0.1297</td>
</tr>
<tr>
<td>Storage Capacity: 92.3 MB</td>
</tr>
<tr>
<td>Storage Available: 91.8 MB</td>
</tr>
<tr>
<td>Network: Wireless client is not attached.</td>
</tr>
<tr>
<td>Login: Not logged in.</td>
</tr>
</tbody>
</table>

2. View the Storage Available field to determine how much storage is available on the handheld.

3. Click OK to return to the Home screen.

Freeing Storage

To free or recover storage, delete documents and/or folders from the handheld. To keep the documents and folders for later use, transfer them to another handheld or to a computer using the TI-Nspire™ software.

Deleting Files from the Handheld

1. Press \[\text{on} \times 2\] to open the My Documents file browser.

2. Press \[\text{up} \text{or down} \] to select the folder or document you want to delete.
3. Press \[ \text{del} \].

—or—

Press \[ \text{ctrl} \, \text{menu} \, 6 \].

A dialog box opens, asking you to confirm the deletion.

![Confirm Document Delete dialog box]

4. Press \[ \text{enter} \] to confirm or \[ \text{esc} \] to cancel.

The folder/document is permanently removed from the handheld.

**Backing up Files to Another Handheld**

1. Connect the two handhelds using the USB-to-USB connectivity cable.
2. Press \[ \text{on} \, 2 \] to open My Documents on the sending handheld.
3. Press the \[ \uparrow \] and \[ \downarrow \] keys to highlight the document you want to send.
4. Press \[ \text{menu} \], and then select \text{Send}.

—or—

Press \[ \text{ctrl} \, \text{menu} \, 2 \].

5. When the file transfer is complete, a message is displayed on the receiving unit.

**Transferring Files to a Computer**

Use the TI-Nspire™ software to transfer files and folders from a handheld to a computer.

1. Connect your handheld to the computer using a standard A to mini-B USB cable.
2. In the TI-Nspire™ software, open the Documents Workspace.
3. In the Documents Toolbox, click \[ \text{Content Explorer} \] to open the Content Explorer.
4. In the Computer pane, navigate to the folder in which you want to save the files.

5. In the Connected Handhelds pane, double-click the handheld name to view the folders and files on the handheld.
6. Select the file or folder you want to save to the computer.
   - Click the file to select one file or folder at a time.
   - To select all files on the handheld, select the first file in the list, hold down the Shift key, and then click the last file or folder in the list.
   - To select random files, click the first file, and then hold the Ctrl key while selecting additional files.

   **Note:** If you select multiple files, it is saved as lesson bundle (.tilb file).

7. Drag the files to the folder in the Computer pane.
   — or —

   Select **File > Save as**.

   The files are copied to the folder on the computer.

8. Verify that the files you need are available on your computer, and then delete the files from the handheld.

   **Note:** Those using the TI-Nspire™ CX Premium Teacher Software or the TI-Nspire™ CX Navigator™ Teacher Software can also use options in the Content Workspace to copy files from a handheld to a computer.

**Resetting the Storage**

Complete these steps only if you want to delete ALL files and folders on your handheld.

**WARNING:** This action clears the copy/paste clipboard, clears Scratchpad, and deletes all user-created files and folders from the handheld. You cannot undo this operation. Before proceeding, consider restoring sufficient available storage by deleting only selected data.
1. After making certain you want to clear all files, press `on` 2 to open the My Documents file browser.

2. Press `menu` to open the context menu.

3. Select Delete All.
   —or—
   Press `C`.
   
   The Delete All dialog box opens.

   ![Delete All dialog box]

   This action will clear the copy/paste clipboard, clear Scratchpad, and delete all files and folders on this device. Do you wish to proceed?

   OK  Cancel

4. Click OK to confirm that you want to clear the handheld storage.
Updating the Handheld Operating System

To take advantage of the latest handheld features and updates, download the latest operating system files from the Education Technology website (education.ti.com). You can update the operating system (OS) on TI-Nspire™ handhelds using a computer and the following software:

- TI-Nspire™ CX Premium Teacher Software (v5.0 and later)
- TI-Nspire™ CX Student Software (v5.0 and later)
- TI-Nspire™ CX CAS Premium Teacher Software (v5.0 and later)
- TI-Nspire™ CX CAS Student Software (v5.0 and later)
- TI-Nspire™ CX Navigator™ Teacher Software
- TI-Nspire™ CX CAS Navigator™ Teacher Software

In the classroom, you can use the TI-Nspire™ Docking Stations to upgrade the OS on multiple handhelds at the same time.

You can also transfer the OS from one TI-Nspire™ handheld to another or from one TI-Nspire™ CX II handheld to another. However, handheld operating systems are not interchangeable. You cannot transfer an Exact Arithmetic or CAS operating system to a non-Exact Arithmetic or non-CAS handheld and you cannot transfer a TI-Nspire™ handheld operating system to a TI-Nspire™ CX II handheld.

For web-based connectivity using your TI-Nspire™ CX II with a Chromebook, Windows® computer, or Mac® computer, go to Ti-Nspire™ CX II Connect.

What You Need to Know

- If there is not enough room on the receiving handheld for the upgrade, a message is displayed. For more information, see File Management.
- OS upgrade operations do not delete user documents. The only time documents are affected by an OS installation is if the receiving handheld has a corrupted OS. In this situation, documents may be affected by OS restoration. It is a good practice to back up important documents and folders before installing an updated operating system.

Before You Begin

Before beginning an OS download, ensure that batteries are at least 25 percent charged.

- To check the status of the rechargeable battery in TI-Nspire™ CX II handhelds, press on 5 4 to open the Handheld Status dialog box.

When in OS download mode, the Automatic Power Down™ (APD™) feature does not function. If you leave your handheld in download mode for an extended time before you begin the downloading process, your batteries may become depleted. You will then need to replace or recharge the batteries before downloading the OS.
Finding Operating System Updates

For up-to-date information about available OS upgrades, check the Texas Instruments website at education.ti.com.

You can download an OS upgrade from the Texas Instruments website to a computer, and use a USB cable to install the OS on your TI-Nspire™ CX II handheld. You will need an Internet connection and the appropriate USB cable to download the updates.

Checking for Handheld OS Updates

When using TI-Nspire™ software, you can quickly determine if your handheld OS is up to date when the handheld is connected to a computer.

1. Open the TI-Nspire™ software and ensure the handheld is connected to your computer.

2. In the Documents Workspace, click to open Content Explorer.

3. In the Connected Handhelds pane, select a connected handheld.

4. Select Help > Check for Handheld OS Update.
   - If the operating system is current, the Check for Handheld OS Update dialog box opens indicating that the operating system on the handheld is up to date.

5. Click OK to close the dialog box.
Performing the OS Update

In the TI-Nspire™ software, you can select to upgrade the operating system on a connected handheld from the following workspaces and menus:

- In all versions of the software, you can select Help > Check for Handheld/Lab Cradle OS Update. Select a connected handheld in the Content Explorer to activate this option. If the OS on the handheld is not current, the dialog box indicates that there is an updated version of the operating system. Follow the prompts to update the operating system.

- In all versions of the TI-Nspire™ software, you can use options available in the Documents Workspace:
  - Open Content Explorer, select the handheld name, and then click and select Install OS.
  - or —
  - Select Tools > Install Handheld/Lab Cradle OS.

- Those using teacher versions of the TI-Nspire™ software can use options available in the Content Workspace:
  - In the Resources pane, right-click the name of a connected handheld, and then select Install Handheld/Lab Cradle OS.
  - or —
  - Select the handheld name in the Preview pane, click in the Preview pane, and then select Install Handheld/Lab Cradle OS.
  - or —
  - Right-click the handheld name and select Install Handheld OS/Lab Cradle OS.

Completing the OS Upgrade

When you select to update the OS on a handheld, the Select Handheld OS File dialog box opens.
The file displayed for selection defaults to the file type required for the selected handheld.

1. Select the OS file:
   - If you are upgrading a TI-Nspire™ CX II handheld, select TI-Nspire.tco2
   - If you are upgrading a TI-Nspire™ CX II CAS handheld, select TI-Nspire.tcc2
   - If you are upgrading a TI-Nspire™ CX II-T (Exact Arithmetic) handheld, select TI-Nspire.tct2

2. Click Install OS to download the OS and update the handheld. The confirmation message “You are about to upgrade your handheld operating system. Any unsaved data will be lost. Do you want to continue?” is displayed.

3. Click Yes to continue.

   The Installing OS dialog box opens indicating the progress of the download. Do not disconnect the handheld.
4. When the download is complete, the Information dialog box opens indicating that the OS file has been successfully transferred to the handheld. You can disconnect the handheld.

![Information dialog box]

5. Click OK.

The updated operating system is installed on the handheld. When the update is complete, the handheld reboots.

6. On the handheld, follow the prompts to:
   - Choose a preferred language.
   - Select a preferred font size.

7. When the Welcome screen opens, click OK.

The Home screen opens.

Transferring the Operating System From Another Handheld

**Note:** You cannot transfer the OS on a TI-Nspire™ handheld to a TI-Nspire™ CX II handheld and you cannot transfer the OS on an Exact Arithmetic or CAS handheld to a non-Exact Arithmetic or non-CAS handheld. The operating systems are not the same and are not interchangeable.

To transfer the OS from one handheld to another:

1. Ensure any open documents on the receiving handheld are closed.
2. Connect the two handhelds using a USB mini-A to mini-B USB cable.
3. On the sending handheld, select Browse from the Home screen.
4. Press [menu], and then select Send OS.
   On a TI-Nspire™ handheld, press (menu).

![TI-Nspire™ handheld menu]

---

*Updating the Handheld Operating System* 87
5. On the receiving handheld, the message, “You are receiving an OS Upgrade. Unsaved changes will be lost. Would you like to continue?” is displayed along with Yes and No response buttons. Select Yes to receive the OS upgrade.
   - If Yes is not selected within 30 seconds, the handheld automatically responds with No, and the transmission is cancelled.
   - It is important to save and close all open documents before performing an OS Upgrade. Continuing with an OS Upgrade on a handheld with an open, unsaved document will cause the loss of that data.

6. While the upgrade is in progress, the following messages are displayed on the receiving and sending handhelds:
   - “Receiving OS. Do not unplug cable.”
   - “Sending OS. Do not unplug cable.”

7. After the transfer completes, the sending handheld receives a completion message and you can unhook the cable. The OS is automatically installed on the receiving handheld. During the installation process, the “Installing OS <version number>” message is displayed on the receiving handheld.

8. When the installation is complete, the “OS <version number> has been installed. Handheld will now restart.” message is displayed. The restart is initiated. If the sending handheld is still attached to the cable, the successful transmission message remains displayed on that handheld’s screen.

**Important:**

- For each receiving handheld, remember to back up information as necessary and install new batteries.
- Be sure the sending handheld is on the Send OS screen.

**Updating the OS on Multiple Handhelds**

In the classroom, use the TI-Nspire™ CX Docking Station to upgrade the OS on multiple handhelds at the same time.

In the teacher versions of the TI-Nspire™ software, you can transfer files from the computer to multiple handhelds from the Content Workspace. See Using the Content Workspace for more information about transferring files to connected handhelds.

**OS Upgrade Messages**

This section lists the information and error messages that can be displayed on handhelds during an OS Upgrade.

<table>
<thead>
<tr>
<th>Shown on: Sending handheld</th>
<th>Message and Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Receiver does not have enough storage space. Make &lt;xxxK&gt; available.“</td>
<td></td>
</tr>
</tbody>
</table>

This message indicates that the receiving handheld does not have enough storage available for the new OS. The space requirement is shown so you know how much storage must be cleared for the new operating system. Files
<table>
<thead>
<tr>
<th>Shown on:</th>
<th>Message and Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sending handheld</td>
<td>“Receiver must change batteries before upgrading the OS.”</td>
</tr>
<tr>
<td></td>
<td>This message indicates that the batteries in the receiving handheld need to be replaced. Send the OS Upgrade once the batteries are replaced.</td>
</tr>
<tr>
<td>Sending handheld</td>
<td>“Receiver has a newer OS and cannot load this OS.”</td>
</tr>
<tr>
<td></td>
<td>OK</td>
</tr>
<tr>
<td></td>
<td>This message indicates that the receiving handheld has a newer OS version than the one being transmitted. You cannot downgrade an OS.</td>
</tr>
<tr>
<td>Sending handheld</td>
<td>“Upgrade not accepted by receiver.”</td>
</tr>
<tr>
<td></td>
<td>OK</td>
</tr>
<tr>
<td></td>
<td>This message indicates that the receiving handheld refuses the upgrade.</td>
</tr>
<tr>
<td>Sending handheld</td>
<td>“OS has been transferred. You can now unplug.”</td>
</tr>
<tr>
<td></td>
<td>OK</td>
</tr>
<tr>
<td></td>
<td>This message indicates that the transfer is complete and it is safe to unplug the cable from the sending handheld.</td>
</tr>
<tr>
<td>Sending handheld</td>
<td>“Sending OS. Do not unplug cable.”</td>
</tr>
<tr>
<td></td>
<td>This message, along with a progress bar, is displayed while the OS Upgrade is being transferred.</td>
</tr>
<tr>
<td>Both handhelds</td>
<td>“Transfer failed. Check cable and try again.”</td>
</tr>
<tr>
<td></td>
<td>OK</td>
</tr>
<tr>
<td></td>
<td>The sending and/or receiving handheld is not properly connected. Reinsert the cable into each handheld, and then try the transmission again.</td>
</tr>
<tr>
<td>Receiving handheld</td>
<td>“You are receiving an OS Upgrade. Unsaved changes will be lost. Would you like to continue?”</td>
</tr>
<tr>
<td></td>
<td>Yes No</td>
</tr>
<tr>
<td></td>
<td>This message is displayed when an OS Upgrade is about to begin. If you do not select Yes within 30 seconds, the system automatically responds with No.</td>
</tr>
<tr>
<td>Receiving handheld</td>
<td>“Receiving OS. Do not unplug cable.”</td>
</tr>
<tr>
<td></td>
<td>This message, along with a progress bar, is displayed while the OS Upgrade is being transferred.</td>
</tr>
<tr>
<td>Receiving handheld</td>
<td>“Installing OS.”</td>
</tr>
<tr>
<td></td>
<td>This message is displayed when the transfer is complete. It is shown to keep you informed of the handheld’s status.</td>
</tr>
<tr>
<td>Receiving</td>
<td>“OS has been installed. Handheld will restart.”</td>
</tr>
<tr>
<td>Shown on: handheld</td>
<td>Message and Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>-------------------------</td>
</tr>
<tr>
<td></td>
<td>OK</td>
</tr>
<tr>
<td></td>
<td>This information message displays briefly before the handheld automatically reboots.</td>
</tr>
<tr>
<td>Receiving handheld</td>
<td>“Install was corrupted. Handheld will reboot. You will need to retry OS upgrade.”</td>
</tr>
<tr>
<td></td>
<td>OK</td>
</tr>
<tr>
<td></td>
<td>An error occurred during the transmission and the installation was corrupted. The handheld will reboot. After the reboot, reinstall the OS Upgrade.</td>
</tr>
</tbody>
</table>
TI-Nspire™ CX II Connect

TI-Nspire™ CX II Connect is an web-based application that provides connectivity between a computer and a TI-Nspire™ CX II graphing calculator. It allows you to capture the calculator screen, transfer .tns files to and from the calculator, and update the OS on the calculator.

System Requirements

- **Browser**
  - Google Chrome version 90 or later
  - Microsoft Edge version 90 or later
- **Computer**
  - Chromebook
  - Windows® 10
  - Mac® OS 10.15 or later
- **Active internet connection**
- **Web USB enabled**
- **Access to shared memory, files, and clipboard**

Supported Calculators

- TI-Nspire™ CX II
- TI-Nspire™ CX II CAS
- TI-Nspire™ CX II-T
- TI-Nspire™ CX II-T CAS
- TI-Nspire™ CX II-C CAS

Getting Started with TI-Nspire™ CX II Connect

1. Open a compatible browser.
2. Enter [nspireconnect.ti.com](http://nspireconnect.ti.com) into the address bar.

   If prompted, click **Agree and Proceed** to accept cookies, and then click **ACCEPT** button to agree with the TI terms and conditions.

   A compatibility check will be performed while the application loads. If any issues are found, a page will display with information on what needs to be addressed.
3. After the Let's Get Started page loads, connect your TI-Nspire™ CX II calculator to your computer.

   **Note:** If your computer only has a USB-C port, you will need a USB-A to USB-C adapter to connect your calculator.

4. Click **CONNECT TO CALCULATOR**.

5. On the popup window, click the name of your calculator and then click **Connect**.

   ![Popup Window](image)

   The home page will open displaying the three available options: Screen Capture, File Transfer, and OS Update.
Navigating on the website

There are two ways to navigate on the TI-Nspire™ CX II Connect website after connecting your calculator:

- TI-Nspire™ CX II Connect logo on the top left of each page which links to the home page
- Links to each function on the top right of each page except the home and Let’s Get Started pages

**Note:** If your calculator is disconnected and then reconnected (or you connect another calculator), you will be redirected to the Let’s Get Started page.

**Using Google Drive**

**Note:** This feature is optional. TI does not save any of your user data if you sign in with Google.

**To use your Google Drive account to save screenshots or transfer tns files:**

1. Click the **Sign in with Google** icon on the top right part of any page.

2. On the **Sign in with Google** popup window, complete the sign in process to connect to Google Drive.
3. When prompted on the standard Google Account dialog, select the checkbox for the option to grant the application access to your Google Drive for transferring files to or from your computer.

After signing successfully, the sign in icon will have a green checkmark and can then be used to sign out of your Google Drive account.

**Note:** When using Google Drive for screen captures or file transfers, you must create the folder(s) you want to use in Google Drive first.

**Disconnecting TI-Nspire™ CX II Connect from Google Drive**

1. In Google Drive, click the settings icon and select **Settings**.
2. On the Settings dialog, click Manage Apps.

3. Locate the TI-Nspire CX II Connect app in the list and then click OPTIONS > Disconnect from Drive.

4. On the confirmation dialog, click DISCONNECT.

5. Click DONE.

**Capturing the Calculator Screen**

To capture the calculator screen:

1. Navigate to the SCREEN CAPTURE page.
2. Click the **CAPTURE SCREEN** button.

The current calculator screen will display.

**Note:** To capture another screen, make the necessary changes on the calculator and click the **CAPTURE SCREEN** button again.

3. Click one of the following buttons:

- Copies the current screen to the computer clipboard and use the image in other apps.

- Saves the current screen to your computer.

- Saves the current screen to Google Drive.

**Note:** When using Google Drive for screen captures or file transfers, you must create the folder(s) you want to use in Google Drive first.

**Transferring Files**

To transfer files to or from the computer:

1. Navigate to the **FILE TRANSFER** page.
2. Click either FROM CALCULATOR or TO CALCULATOR and follow the corresponding instructions below.

**Note:** Only .tns files can be transferred. Other file types will not be shown. Also, files on the calculator must be in the My Documents folder, not a sub folder.

**Transferring files from the calculator to the computer**

Choose the file(s) from the My Documents folder on the calculator that you want to send to the computer.

**Note:** Check or uncheck the Select All box to highlight or clear the selection of all files.

**To transfer files to Google Drive:**

1. Click TO GOOGLE DRIVE.
2. Click on the folder you want to save the files to and click Select.
Note: When using Google Drive for screen captures or file transfers, you must create the folder(s) you want to use in Google Drive first.

Note: If you transfer files that already exist on Google Drive, they will be automatically overwritten.

3. When the Files Sent list appears, you can click SEND MORE FILES or the BACK link to select more files to transfer.

To transfer files to the computer:

1. Click TO COMPUTER.
2. Click on the folder you want to save the files to and click Select Folder.
3. When prompted to let the site view files, click View files.
4. When prompted to save changes to the destination folder, click Save changes.
   
   Note: If you transfer files that already exist on the computer, a copy of the file will be created with a number appended to the file name.

5. When the Files Sent list appears, you can click SEND MORE FILES or the BACK link to select more files to transfer.

Transferring files from the computer to the calculator

1. Click either FROM GOOGLE DRIVE or FROM COMPUTER.

2. Locate and select the file(s) to transfer.

   Note: If you transfer files that already exist on the calculator, a copy of the file will be created with a number appended to the file name.
3. When the **Files Sent** list appears, you can click **SEND MORE FILES** or the **BACK** link to select more files to transfer.

   **Note:** If you transfer files that already exist on the calculator, a copy of the file will be created with a number appended to the file name.

4. On the calculator a prompt will display with the following options:

   **Open** - Opens the file that was transferred.

   **Go To** - Opens the My Documents folder and highlights the file that was transferred.

   **OK** - Clears the prompt.

   **Note:** If you transfer multiple files the prompt will only apply to the last file that was transferred.

**Updating the OS**

**To update the OS on the calculator:**

1. Navigate to the **OS UPDATE** page.

   The app will check the OS version on the calculator. If there is a newer version available, you will be prompted to update.

2. Click the **UPDATE OS** button.

   A confirmation message will appear when the update is finished.
General Information

Online Help

education.ti.com/eguide

Select your country for more product information.

Contact TI Support

education.ti.com/ti-cares

Select your country for technical and other support resources.

Service and Warranty Information

education.ti.com/warranty

Select your country for information about the length and terms of the warranty or about product service.

Limited Warranty. This warranty does not affect your statutory rights.

Texas Instruments Incorporated

12500 TI Blvd.

Dallas, TX 75243

Precautions for Rechargeable Batteries

- Do not expose batteries to temperatures above 140°F (60°C).
- Do not disassemble or mistreat batteries.
- Use only the charger recommended for the cell or battery, or the one that was provided with the original equipment.
- TI recommends that you use the USB cable included with this calculator. If you choose to use a third-party power adapter with the TI-supplied USB cable, you should use an adapter that meets applicable safety and operational standards and certifications, including UL and CE certifications.

Take these precautions when replacing rechargeable batteries:

- Replace only with a TI approved battery.
- Remove the cell or battery from the charger or alternating current adapter when not in use or being charged.
- Use of the battery in other devices may result in personal injury or damage to equipment or property.
- Do not mix brands (or types within brands) of batteries. There is a risk of explosion if a battery is replaced by the wrong type.
Disposing of Batteries

Do not mutilate, puncture, or dispose of batteries in fire. The batteries can burst or explode, releasing hazardous chemicals. Discard used batteries according to local regulations.